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Here’s	how	to	use	the	offset	feature	to	make	a	knockout	design.Step	1:	Click	Text,	type	in	your	Step	2:	Click	Text,	type	an	accent	Step	3:	Select	the	accent	wordmain	word	using	a	bold	font	like	word	in	a	script	font	(i.e.,	I	Love	layer,	click	on	Offset,	and	slideCricut	Sans	Bold.	on	your	Cricut!	I	also	have	a	free	writing	font	you	can	use	at	https://
jennifermaker.com/	writing-font	Practice	this	at	|Page	62	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	Score	with	a	stylus	or	wheelStep	1:	Step	2:	Step	3:Open	or	Tap	Layers	Changecreate	a	and	make	lines	toproject	sure	any	scores	bywith	score	lines	to	be	tappinglines.	tap	Actions,	and	tap	letter	so	it’s	basetext.	If	you	only	see	the	ZIP
file,	you’ll	need	to	first	decompress	the	ZIP	file	(open	it)	by	double-clicking	it	in	your	Finder.	Practice	this	at	Page	28	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	tosave	for	offline	workIf	you’re	using	Design	Space	for	Desktop	(see	pages	4	and	5),	you	can	save	projects	for	offline	andaccess	them	even	when	you	aren’t	connected	to	the
Internet.	something	awesome!Do	you	have	a	strong	Internet	connection?	LINETYPE	&	TOOLSThe	Cricut	Explore	adds	Score.	CCroiaccuht®Playbook	Quick	and	easy	one-page	diagrams	for	popular	tasks	in	Cricut	Design	Space®	Coach	by	JenniferMakerCricut®	Coach	PlaybookAbout	this	PlaybookThis	Playbook	gives	you	quick	and	easy	visual	steps	for
every	popular	task	in®Cricut	Design	Space	.	Let’sfix	that.Step	3:	The	letter	Step	4:	Select	just“D”	is	too	close	the	letter	“D”	thento	the	“o”	in	the	tap	Edit,	then	tapexample	here.	So	either	projects!tap	Cancel	(ifyou	want	to	OPEN	&	START	PROJECTsee	what	youleft	there)	ortap	Replace	fora	new,	blankcanvas.	layers	the	called	layers	“Sliced	you	Image”
do	not	will	want,	appear	then	in	your	you’re	Layers	good	to	panel.	together.	If	you	tap	Weld	instead,	it	will	stick	them	together	permanently.	It	is	fine	to	replace	to	any	of	your	images	or	fonts.	You	can	do	this	if	you	reposition	items	on	your	mat	before	you	cut!	Here’show	to	do	it	on	an	iOS	device	(iPhone	or	iPad):Step	1:	Open	or	Step	2:	Makecreate	a
project.	The	Attach	feature	also	helps	you	affix	a	write	orscore	layer	to	a	cut	layer.Step	1:	Add	all	of	your	elements	to	Cricut	Step	2:	Ungroup	any	groups.	Practice	this	at	|Page	49	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	GROUP	/	UNGROUP	group	and	ungroupGrouping	lets	you	keep	objects	together	in	your	design	but	not
necessarily	on	your	mat	(you	still	need	touse	the	Attach	function	to	keep	things	together	on	the	mat).	Open	design	space	and	Advertisement	Advertisement	Advertisement	The	111-page,	full-color	Playbook	is	easily	worth	$50	or	more,	but	for	limited	time	I'm	offering	it	at	just	$19	$12.35	for	Black	Friday.	(You	do	not	need	the	Curve	tool	at	the	top.	Be
aware	that	changing	an	object	to	pattern	fill	will	also	change	it	CHANGE	COLORS/FILLSto	a	print	then	cut	image.	what	others	will	see.Here	is	an	example	of	a	project	link:	|Page	30	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	LINK	CARTRIDGESlink	cartridgesStep	1:	Open	Cricut	Design	Space,	click	the	Step	2:	Choose	your	Cricut
from	the	drop-downmenu	in	the	upper	left	corner,	and	choose	Link	menu.	the	dimensions	of	your	actual	item	so	the	template	matches.	COMBINE	PROJECTSStep	3:	Locate	and	open	the	project	you	want	to	Step	4:	Click	Edit	and	choose	Paste.combine	your	first	project	with.Your	layers	from	the	first	project	appear	on	thecanvas	with	the	second	project!
Practice	this	at	and	|Page	37	Copyright	JenniferMaker®Cricut®	Coach	Playbook	UPLOAD	SVG	FILES	(MAC)	How	to	UploadSVG	Files	on	a	Mac	Step	3:	Click	Browse	Step	4:	Select	the	SVG	File	and	click	OpenStep	1:	Step	2:Click	Upload	Click	Upload	Image	Tip:	Type	a	word	or	two	as	a	Notes:	tag	to	help	you	find	this	image	Be	sure	you	select	the	SVG
file,	later	in	a	search.	This	is	AppNOT	the	same	as	turning	your	Storedevice	on	and	off.	If	you	ever	type	NEW	text	and	cannot	find	it	on	your	Android,	zoom	out	and	check	the	upper	left	corner—that’s	usually	where	you’ll	find	it!Coach	|Page	93	Copyright	JenniferMaker®Cricut®	Coach	PlaybookStep	1:	Select	How	to(tap)	the	layer	change	colorsyou
want	tochange,	like	the	Step	2:	Tap	Editcenter	of	this	then	tap	theflower.	If	you	keep	slicing,	you	can	make	some	pretty	amazing	designs!Step	1:	Step	2:	Step	3:Insert	your	Tap	the	Selectimages	onto	Layers	theyour	Canvas	icon	to	layersso	that	open	the	you	wantthey	are	Layers	to	sliceoverlapping.	Flatten	is	your	friend!	The	Flatten	tool	allows	you	to
turn	anyimage	into	a	single,	printable	layer	for	the	Print	then	Cut	feature.Step	1:	Add	two	or	more	itemsto	your	canvas	that	you	want	toflatten.Note:	Flatten	is	used	only	forprint.Step	2:	Click	and	drag	a	selectionbox	around	all	objects	you	want	toflatten	to	select	all	of	them.Step	3:	Click	the	Flattenicon	in	the	bottom	rightcorner.Note	that	all	items
arenow	on	one	layer	and	now	workonly	for	Print	Then	Cut.If	you	decide	this	isn’twhat	you	wanted	todo,	click	the	Unflattenbutton	right	away.	elementson	a	light	or	If	you	on	to	thewhite	colored	like	it,	best	spotssurface.	If	you’d	Space,	like	to	revisit	this,	click	here	click	the	menu	icon	in	to	create	the	upper	left	corner	a	free	and	choose	account.	Make
anything	Step	2:	Make	sure	the	items	you	want	toyou	want	to	appear	on	the	same	mat	the	same	reposition	are	all	on	the	same	mat.color.	CONNECT	VIA	BLUETOOTH	|Page	82	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	ATTACHto	keep	things	togetherDid	you	tap	Make	It	and	find	all	of	your	elements	re-ordered	and	out	of	place?
Eachtime	I	do	a	major	update	of	the	Playbook,	Iwill	send	you	an	email	notifying	you	of	theupdate	along	with	a	download	link	to	get	theupdate	free	of	charge.	Note:	If	your	design	has	any	purchased	elements	from	Cricut	Access	or	cartridges,	anyone	attempting	to	use	your	design	must	also	have	them	or	they	will	be	prompted	to	pay	for	them.Step	3:
Add	at	least	one	landscape	photo	by	Step	4:	Add	a	description	and	make	sure	Anyone	SHARE	PROJECT	LINKSclicking	the	+	button.	then	click	the	Weld	button	in	the	lower	right	corner.Note:	If	you	are	trying	to	create	a	single	image	with	Tip:	You	can	select	items	within	groups	to	weldWeld,	make	sure	all	elements	are	overlapping.	Here’s	howto
choose	a	good	font	that	looks	like	handwriting	and	set	it	to	Draw	in	Cricut	Design	Space:Step	1:	Click	Text,	click	the	Font	menu,	click	Step	2:	Select	a	writing	font	(such	as	the	freeFilters,	and	select	Writing	to	see	writing	fonts.	See	page	means	you’re45	for	directions	not	signed	in.on	how	to	install	Tap	the	circleCricut	Design	Space	to	sign	in!on	your
iPhone	oriPad.	If	you	keep	slicing,	you	can	make	some	pretty	amazing	designs!Step	1:	Insert	your	images	onto	your	Step	2:	Select	just	two	layers	(hold	the	ShiftCanvas	so	that	they	are	overlapping.	smooth	and	your	letters	so	they	arethe	circle.	You	can	tell	it	is	the	SVG	file	because	its	“Type”	is	listed	as	“SVG	Document”	in	your	file	browser	(it	may	say
“Chrome	HTML”	or	“Edge	HTML”	instead).	to	launch	it.Note:	If	you	get	this	warning,	you	need	to	open	Step	4:	If	prompted,	sign	in	with	your	CricutSystem	Preferences,	click	on	Security,	account	email	and	password.	To	turn	them	off,	tap	Settings	in	the	bottom	toolbar	and	toggle	off	SmartGuides.Coach	Practice	this	at	|Page	54	Copyright
JenniferMaker®Cricut®	Coach	Playbook	How	to	align	anddistribute	objectsStep	1:	Add	two	or	more	Step	2:	Tap	and	drag	aitems	to	your	canvas	selection	box	aroundthat	you	want	to	align	or	all	items	you	want	todistribute	evenly.	the	top	to	see	the	options.	Practice	this	at	|Page	64	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	mirror	and
cut	iron-on	vinylWant	to	make	a	T-shirt	or	bag	with	iron-on	vinyl?	(Note:	You	cannot	use	the	Knife	orFoil	Transfer	tools	from	Android	devices.)	Here’s	how	to	set	your	machine	and	change	the	linetype.Step	1:	Step	2:	Tap	Cut	thenTap	the	Tap	a	4	to	use	thecircle	layer,	fine	point,menu	in	then	tap	deep	cut,the	upper	Edit,	fabric,	orleft,	tap	then	tap	rotary
(MakerMachine	Linetype.	Select	the	accent	wordUnlock	it,	resize	it	to	make	it	as	needed,	unlock	it,	resize	it,	layer,	go	to	the	Linetype	menu,taller,	and	click	Weld.	Yes	No	Have	fun	and	make	No	Are	you	still	having	problems?	align	and/or	distribute.Step	3:	Tap	on	the	Edit	Step	4:	All	selected	ALIGN	AND	DISTRIBUTEtool	in	the	bottom	items	are
centered.toolbar,	tap	Align,	and	Now	let’s	space	themtap	Align	Center.	NowIsolate.	Whendone,	tap	thecheckmark.Note	that	you	cannot	set	pattern	fills	in	the	Android	version	of	Cricut	Design	Space.	Still	having	problems?	step	4.Step	3a:	Step	4:	Make	Step	5:Tap	the	sure	your	score	Make	suremenu	at	line	is	attached	the	scorethe	top,	to	the	layer	you
line	is	onthen	tap	want	scored	(look	the	sameScore	for	the	words	layer	asin	the	“Attached	Set”	the	cut,Linetype	above	the	score	then	tapmenu,	and	base	layers	to	confirm),	Continue.then	tap	then	tap	Make	It.	If	they	areApply.	Cricut	Coach	Playbook:	Quick	and	Easy	One-Page	Diagrams	for	Popular	Tasks	in	Cricut	Design	Space	Cricut	Coach	Playbook:
Quick	and	Easy	One-Page	Diagrams	for	Popular	Tasks	in	Cricut	Design	Space	Advertisement	Cricut	Design	Space	Cheat	Sheets	Navigate	Cricut	Design	Space	and	learn	how	to	design	and	create	with	confidence	with	these	FREE	Cricut	Design	Space	Cheat	Sheets!	Cricut	Design	Space	for	Dummies	New	to	the	Cricut	world?	To	update	your	layer	order,
select	anto	be	the	same	color!	Attach	layer,	click	on	Arrange,	and	select	a	new	order.	Fix	this	and	keepeverything	exactly	where	you	want	with	the	ATTACH	button.	Blade	problems:	Check	my	blade	tips	at	Are	you	still	having	problems?	Bluetooth.Note:	Your	Cricut	must	be	within	10-15	feet	Step	4:	If	you	CONNECT	VIA	BLUETOOTHof	your	device.
Practice	this	at	|Page	32	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	print	then	cutStep	1:	Find	or	upload	a	printable	image	less	than	9.25”	high	by	6.75”	wide	with	one	of	these	two	methods:Method	A:	Search	for	printable	images	in	Design	Method	B:	Upload	a	PNG	with	a	transparentSpace	by	clicking	on	Images,	then	under	Operation
background,	choose	the	image	type	that	suits	yourType,	check	the	box	next	to	“Print	then	Cut.”	image	the	best	(I	recommend	“Complex”),	then	click	Continue.Tip:	Click	“Free”	Erase	anything	you	don’t	Select	the	image	on	theunder	Ownership	on	want	&	click	Continue.	So	if	you	want	to	attach	and	have	an	issue,	look	for	ALL	groups	and	ungroup	them
first.Coach	Practice	this	at	|Page	50	Copyright	JenniferMaker®	Page	2	Cricut®	Coach	PlaybookHow	to	WELDNeed	to	join	elements	to	create	a	new	image?	button	to	the	right	of	it.Step	4:	Step	5:	Step	6:Tap	the	Change	the	Whensetting	settings	done,	tapyou	want	here	as	Save.to	change,	needed.likely	the	Usually	Ione	labeled	just	adjustPreferred.	If
not,upgrade	first.11Step	4:	Step	5:	Step	6:	Once	inserted,	your	UPLOAD	SVG	FILES	(IOS)Tap	the	SVG	file	(do	Tap	Save.	blade-tipsDisconnect	your	Cricut,	restart	your	Yes	Nodevice,	and	reconnect	your	Cricut.	However,	if	you	ungrouptext	from	its	shadow	layer,	it	becomes	an	image	and	will	no	longer	work	with	the	Slice	tool	unless	thetext	is
ungrouped	to	individual	letters.	Unlock	Adjust	letters	take	a	screenit,	resize	it	as	needed,	shot	(holdto	make	it	unlock	it,	down	thetaller,	and	resize	it,	and	Power	andtap	Actions	>	tap	Actions	>	Volume	UpWeld.	To	turn	them	off,	tap	Settings	in	the	bottom	toolbar	and	toggle	off	SmartGuides.	except	the	word	layer.	to	do	next.	Get	simple	directions	for
getting	started	with	Cricut	Design	Space	for	Dummies.	Sometimes	when	you	weld,	the	centers	fill	in—here’s	how	to	fix	that:Step	1:	Tap	Step	2:	If	you	Step	3:	Repeat	step	2	until	youText,	type	in	get	a	center	can	weld	and	the	letter	centerscript	text,	filling	in	(like	does	not	fill	in	(you	may	havechange	your	the	p	here),	to	get	REALLY	big),	then
resizeletter	spacing	tap	Undo,	back	down	to	the	right	size.so	the	letters	then	useoverlap	a	bit	the	Resize(see	page	handle	to90),	select	make	yourall,	then	tap	text	MUCHActions	>	larger,	thenWeld.	these	words	are	properly	spaced.	apart	now.	Resize	the	circle	to	Isolate	Letters.	of	the	screen.Step	4:	Step	5:	Step	6:Toggle	Verify	that	Tap	on	AllMirror	to
your	image	Materials.the	on	is	mirrored,position	then	tapand	tap	on	Continue.the	grayarea	to	MIRROR	/	IRON-ON	VINYLclose	thispanel.Step	7:	Step	8:	Remember,	put	the	vinylSearch	Place	SHINY	SIDE	DOWN	on	yourfor	“iron”	your	iron-	cutting	mat!and	select	on	vinylthe	type	on	yourof	iron-on	cuttingvinyl	you	mat	shinyplan	to	use.	Here	are	the
steps	I	take	when	Iencounter	problems	with	Cricut	Design	Space:	Cricut	Design	Space	is	acting	weird	or	not	working	at	all.	on	Cricut	Design	Space.	Note	that	you	cannot	currently	share	a	project	from	the	Android	version	of	Cricut	Design	Space,	but	you	can	save	a	project	onCoach	Android	and	then	access	and	share	it	from	the	desktop	version.	Not	all
Windows	usershave	the	system	requirements	to	use	Offset,	however,	so	here	is	an	alternate	workaround:Step	1:	Click	Text,	type	in	your	Step	2:	Click	Text	again,	type	an	Step	3:	Select	the	main	wordmain	word	using	a	bold	chunky	accent	word	in	a	script	font	(i.e.,	layer	and	click	the	Eye	icon	tofont	like	Cricut	Sans	Bold.	and	click	Weld.	Here’s	how
tochoose	a	good	font	that	looks	like	handwriting	and	set	it	to	Draw	in	Cricut	Design	Space:Step	1:	Tap	Step	2:	Step	3:Text,	tap	the	Select	a	Tap	Edit,Filter	icon,	writing	tap	Style,and	scroll	font	then	tapdown	to	tap	(such	as	Writing	toWriting	to	the	free	select	thesee	writing	Cricut	Writingfonts.	circle	below.	The	more	you	slide,	the	upward	curve.
Practice	this	at	|Page	70	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	print	then	cutStep	1:	Find	or	upload	a	printable	image	less	than	9.25”	high	by	6.75”	wide	with	one	of	these	two	methods:Method	A:	Search	for	printable	Method	B:	Upload	a	PNG	with	a	transparent	background.	Check	my	mat	tips	at	sure	your	Cricut	is	actually	Yes	No
mat-tipsconnected	via	Bluetooth.	Give	it	some	time	to	load	yourManage	Custom	Materials.	Adjust	lettering	the	distance	bar	to	theit,	resize	it	to	make	it	as	needed,	unlock	it,	right	about	.1	inch,	thentaller,	and	click	Weld.	again.Tip:	Contour	isn’t	permanent	so	long	as	you	don’t	Weld	your	images!	If	you	decide	later	you	want	a	CONTOUR	(REMOVE
BITS)Contoured	image	to	go	back	the	way	it	was,	or	simply	edit	it	further,	all	the	hidden	parts	are	retained!	Practice	this	at	|Page	87	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	Curve	TextStep	1:	Tap	the	Text	Step	2:	Tap	Shapes	Step	3:	Tap	the	text,	Step	4:	Move	eachtool	and	add	some	then	tap	Circle.	UPDATE	APP	(PC)To	see	what
new	features	are	available	to	you,	go	to	the	menu	in	the	upper	left	and	choose	What’s	Newor	go	to	jennifermaker.com/cricut-release-notes.|Page	43	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	troubleshoot	Design	Space	problemsYour	ability	and	willingness	to	troubleshoot	problems	is	a	high	factor	in	your	success	with	your	Cricut
(andreally,	most	things	in	life).	So	only	ATTACH	THINGS	TOGETHER	attach	layers	that	you	really	want	to	be	the	same	color!	Tip:	If	you	are	having	a	problem	attaching	layers,	try	ungrouping	layers	first.You	can	verify	that	your	images	are	Score	lines	must	be	attached	with	theattached	by	tapping	Layers	and	noting	that	appropriate	cut	layer	in	order
for	them	tothey	are	now	labeled	“Attached	Set.”	score	on	the	right	layer,	as	shown	below.	Weld	keeps	your	project	together	on	the	canvas	and	when	you	send	it	to	the	mat	to	cut.	PRINT	THEN	CUTimages	in	Design	Space	bytapping	Filter	and	checking“Printables”	under	Type.	Ifso,	you	may	need	to	delete	and	reinstall	the	app	to	get	things	back	to
working	order.	Click	Make	It.Step	3:	Make	sure	the	score	line	is	on	the	same	Step	4:	Check	the	necessary	tools.	Just	follow	along	with	the	steps	and	you’ll	be	good	to	go!I	update	this	Playbook	whenever	there	aremajor	changes	to	Design	Space,	and	allPlaybook	purchasers	get	free	updates.	press	&	hold	the	image,	and	tap	Add	to	Photos.Step	7:	Return
Step	8:	Verify	Step	9:	Insert	KNOCKOUT	TEXT	(iOS)to	Design	that	your	the	knockout,Space,	tap	image	has	a	resize	it	toCancel	until	transparent	match	youryou’re	back	to	background,	accent	word,your	Canvas,	and	tap	Next.	Use	Contour	to	remove	existing	parts	from	projects.Step	1:	Choose	Step	2:	Tap	onan	image	with	the	elements	youelements
you’d	want	to	remove.like	to	remove	You	can	makethen	tap	Actions,	the	image	largerthen	tap	the	Hide	(to	see	detail)Contour	tool	in	by	pinching	tothe	lower	right	zoom.corner	of	the	appwindow.Step	3:	Elements	Step	4:	Confirmthat	appear	darker	that	your	imageare	those	that	you’ll	looks	the	wayremove.	Ifimage	looks	the	way	you	need	to	makeyou
want	it	to,	click	more	changes,the	Hide	Contour	just	click	theicon	again	in	the	Hide	Contour	toollower	right	hand	again.corner	to	return	toyour	canvas.Tip:	Contour	isn’t	permanent	so	long	as	you	don’t	Weld	your	images!	If	you	decide	later	you	want	a	CONTOUR	(REMOVE	BITS)Contoured	image	to	go	back	the	way	it	was,	or	simply	edit	it	further,	all
the	hidden	parts	are	retained!	Practice	this	at	|Page	53	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	curve	textStep	1:	Tap	the	Text	Step	2:	Tap	Shapes	Step	3:	Tap	the	text,	Step	4:	Move	eachtool	and	add	some	then	tap	Circle.	open	and	you’ll	see	this	screen.Step	4:	If	prompted,	sign	in	with	your	Cricut	Tip:	If	you	areaccount	email	and
password.	•	You	can	only	Slice	with	two	layers.	When	your	you	want	it.	Kerning	isautomatic	for	many—but	not	all—fonts	in	Cricut	Design	Space.	Collections.	tools,	if	you	wish,	then	click	Continue.Step	7:	Choose	Print	Then	Cut	or	Cut	Image,	type	Once	inserted,	your	image	appears	in	Cricut	Design	UPLOAD	IMAGES	(MAC)a	name,	and	click	Continue.
Practice	this	at	|Page	67	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	save	for	offline	workWith	the	Cricut	Design	Space	for	iOS	app,	you	can	save	projects	for	offline	and	access	them	even	when	youaren’t	connected	to	the	Internet.	create	for	ease	in	finding	them	later.	Updates	may	happen	automatically	folder,	then	press	Command	+
Iupon	launching	the	app,	or	if	the	app	is	open	when	the	update	isdetected,	you	will	be	prompted	to	update	your	application—if	thishappens,	save	your	work	and	accept	the	update.If	you	are	ever	unsure	if	you	have	the	latest	version	of	the	app,	goto	the	Release	Notes	at	jennifermaker.com/cricut-release-notes,check	the	latest	version,	and	compare	it	to
yours.	then	click	Make	It.Step	7:	Tap,	hold	Step	8:	Insert	the	pen	in	your	Cricut’s	accessory	WRITE	WITH	A	PENand	drag	the	text	clamp,	position	your	material	on	the	cutting	mat,to	the	exact	spot	load	your	mat,	and	press	the	flashing	button.you	want	it	to	bewritten	on	your	See	my	blog	post	atmaterial	on	the	mat	(see	com/cricut-writing	forpage	64),
then	more	tips	on	writingclick	Continue.	all	items	you	want	to	align	and/or	distribute.Step	3:	Click	on	the	Align	tool	in	the	Step	4:	All	selected	items	are	aligned	with	thetoolbar	and	choose	Align	Top.	Then	click	Done.	Practice	this	at	|Page	60	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	linetype	and	toolsThe	Linetype	menu	lets
you	change	the	tool	for	a	layer.	You	can	tell	see	Save	As	appear,if	something	is	unsaved	if	that	means	you	savedit	says	“Untitled”	at	the	it	before	and	you	havetop	of	the	window,	or	an	the	option	to	saveasterisk	*	appears	next	it	with	a	differentto	the	title	if	you	saved	name	to	preserve	thepreviously.	I've	been	selling	online	for	2	years.	Practice	this	at
|Page	86	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	removeparts	with	contourNeed	to	erase	parts	of	an	existing	design?	larger,	then	click	Weld	again.	Here’s	how	to	choosea	good	font	that	looks	like	handwriting	and	set	it	to	Draw	in	Cricut	Design	Space:Step	1:	Tap	Step	2:	Step	3:Text,tap	the	Select	a	Tap	Edit,Filter	icon,	writing	tap
Style,and	scroll	font	then	tapdown	to	tap	(such	as	Writing	toWriting	to	the	free	select	thesee	writing	Cricut	Writingfonts.	Practice	this	at	Page	36	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	tocombine	multiple	projectsWhile	there	is	no	built-in	function	in	Design	Space	that	allows	you	to	combine	projects,	there	is	a	simpleworkaround.	To
turn	them	off,	tap	Settings	in	the	bottom	toolbar	and	toggle	off	SmartGuides.Coach	Practice	this	at	|Page	90	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	WELD	textand	keep	letter	centersWelding	text	can	be	a	little	tricky.	Sharedprevious	page)	and	projects	must	have	a	title,tap	Share.	(You	cannot	share	projects	with	images	you
uploaded.)Step	1:	Open	a	Step	2:	You	will	likelyproject	you	saved	be	prompted	for	morein	the	Cloud	(see	information	first.	Here’s	how	you	do	it:Step	1:	Open	the	project	you	want	to	Step	2:	Go	to	the	File	menu	at	the	very	top	ofadd	to	another,	select	all	layers,	click	your	screen	and	select	New	Window.Edit,	and	select	Copy.	(Others	cannotopen	and
make	projects	with	images	you	uploaded.)Step	1:	Open	a	project	you	saved	and	Step	2:	You	will	likely	be	prompted	for	moreclick	Share.	Practice	this	at	|Page	63	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	reposition	items	on	mat	previewNeed	exact	control	over	where	items	on	your	mat	are	cut?	So	only	attach	layers	that	you	really
want	attached.	use	the	Foil	Transfer	Tool,	thenPerforate	to	use	the	Perforation	Click	the	box	to	the	right	to	chooose	the	tip	size	(ExploresTool	(Makers	only).	|Page	2	Copyright	JenniferMaker®Cricut®	Coach	PlaybookPlaybook	indexHow	To...	Be	sure	to	hide	the	layer	(click	the	eye	icon)	before	you	cut	it	to	avoid	cutting	out	the	template,	too.Coach
|Page	27	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	save	workand	view	saved	projectsStep	1:	Create	something	and	click	Save.	Here’s	how	you	do	it:Step	1:	Step	2:	Step	3:	Take	a	picture	of	Design	COMBINE	PROJECTSOpen	the	If	any	Space	screen	by	pressing	the	Sideproject	individual	button	and	the	Volume	up	buttonyou	want
elements	at	the	same	time.	|Page	47	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	fix	missing	options	(reinstall	the	IOS	app)Is	your	Shapes	button	grayed	out	in	your	Cricut	Design	Space	app?	Sometimes	when	you	weld,	the	centers	fill	in—here’s	how	to	fix	that:Step	1:	Click	Text,	type	in	script	Step	2:	If	you	get	a	center	filling	Step	3:
Repeat	step	2	until	youtext,	change	your	letter	spacing	in	(like	the	p’s	descender	here),	can	weld	and	the	letter	centerso	they	are	overlapping	a	bit	click	Undo,	then	use	the	Resize	does	not	fill	in	(you	may	have(see	directions	on	page	16),	handle	to	make	your	text	MUCH	to	get	REALLY	big),	then	resizeclick	Select	All,	then	click	Weld.	panel	in	the	three-
panel	icon	to	take	you	Home,	then	tap	the	Categories	menu	and	choose	My	Projects	on	this	iPhone	(or	iPad).	You	can	share	projects,	but	in	order	forsomeone	else	to	open	and	make	them,	there	must	be	no	uploaded	images	in	your	project.	Want	to	cut	one	mat	with	multiple	piecesof	paper	in	different	colors?	mat,	then	tap	Continue.	If	you	do	not	see	it,
make	sure	it	is	turnedCartridges.	Cricut	Member	Care	is	very	helpful!	|Page	44	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	installCricut	Design	spaceStep	1:	Connect	Step	2:	Tapyour	iPhone	the	Searchor	iPad	to	the	icon	and	typeInternet	through	in	Cricut,	thenWiFi	or	Cellular	tap	CricutData	and	tap	the	Design	Space.App	Store	icon
onyour	iPhone	oriPad.Step	3:	Tap	Step	4:	IfDownload	to	prompted,download	and	sign	in	withinstall	Cricut	your	CricutDesign	Space.	tap	Cricut	Design	Space	app.	All	Cricutthe	My	Projects	link	in	the	top	right	members	can	create	upcorner	of	your	window,	or	click	the	to	five	free	Collections.Projects	icon	on	the	left	side	of	the	Cricut	Access
subscriberswindow	and	select	“My	Projects”	can	create	unlimitedfrom	the	Projects	drop-down	menu.	with	link	is	selected.	by	clicking	on	their	names	in	the	Layers	panel	while	holding	down	the	Shift	key.Once	your	images	weld,	they	will	change	to	the	Note:	You	can	unweld	ONLY	if	it	is	the	currentsame	color	and	a	new	image	appears	in	the	Layers
project	on	your	Canvas	and	you	recently	weldedpanel.	There	are	so	many	things	you	can	make	by	cutting	text	with	your	Cricut,	the	possiblities	are	endless.	Tap	imageyour	Cut	Image	from	stepcurrent	then	tap	4.canvas.	not,	tap	Machine	Setup.	outside,	likep,	q	and	0,	4,	Step	5:	this:6,	8,	and	9.	tap	Actions	>	Weld	again.Another	thing	that	can	happen
with	text	is	that	letter	centers	(the	interior	white	space)	can	disappearwhen	you	cut	them	out.	But	you	can	connect	the	spaces	and	keep	the	centers!	Here’s	how	to	fix	that:Step	1:	Tap	Step	2:	Tap	Step	3:	Tap	KEEP	LETTER	CENTERSText,	type	Shapes,	and	drag	thetext,	and	select	a	rectanglelook	for	square,	and	over	aletters	&	Unlock	it	letter
withnumbers	and	Resize	interior	whitewith	interior	it	so	it	forms	space	so	it’swhite	space	a	rectangle	connecting(counters),	about	the	the	spacelike	A,	B,	D,	width	of	inside	toO,	P,	Q,	R,	a,	the	letter’s	the	spaceb,	d,	e,	g,	o,	strokes.	Desktop	(Win/Mac)	iOS	(iPhone/iPad)	AndroidHow	to	Install	Cricut	Design	Space	4/5	45	80Open	and	Start	a	New
ProjectConnect	to	Your	Cricut	(Bluetooth)	6	46	81Attach	(Keep	Things	Together)Group	and	Ungroup	7/8	47	82WeldSlice	9	49	83ContourCurve	Text	10	50	84Align	&	Distribute	Objects	11	51	85Kern	&	Change	Letter	SpaceWeld	Text	&	Keep	Letter	Centers	12	52	86Offset	and	Knockout	TextChange	Font	of	Existing	Text	13	53	87Change	Colors	&
Pattern	FillsChange	Operation	&	Use	Tools	14	54	88Set	Text	to	Write	with	a	PenScore	with	Stylus	or	Wheel	15	55	89Reposition	Items	on	Mat	PreviewMirror	and	Cut	Heat	Transfer	Vinyl	16	56	90Use	and	Resize	TemplatesSnapMat	17	57	91Save	Work	and	View	Saved	ProjectsSave	for	Offline	18	/	19	58	92Share	Links	to	ProjectsLink	Cartridges	20	59
93FlattenPrint	Then	Cut	21	60	94Upload	ImagesErase	Background	from	Image	22	61	95Combine	Multiple	Projects	TogetherUpload	SVG	Files	23	62	96Resize	a	ProjectUse	and	Modify	Custom	Materials	24	63	97Get	UpdatesTroubleshoot	Problems	25	64	98	26	65	99	27	not	a	feature	not	a	feature	not	a	feature	66	not	a	feature	28	67	100	29	68	not	a
feature	30	69	not	a	feature	31	not	a	feature	not	a	feature	32	70	101	33	71	not	a	feature	34	/35	72	102	36	73	103	37	74	104	38	/	39	75	105	40	76	106	41	77	not	a	feature	42	/	43	78	107	44	79	108|Page	3	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	install	Cricut	Design	space	(Mac)Cricut	Design	Space	is	the	free	software	you’ll	use	to
make	amazing	things	on	your	Cricut.	accent	word,it	transparent,	unhide	yourthen	tap	Next.	Use	Weld	when	you	want	to	eliminate	the	cut	lines	between	two	images	or	letters.	All	rights	reserved.	layers	to	see	better.Step	7:	Click	and	drag	the	accent	word	inside	the	empty	space	sliced	out	of	the	main	word,	with	theaccent	word	selected,	click	the	color
box	to	change	the	accent	word	color	if	desired,	and	click	Make	It!	Practice	this	at	OFFST/KNOCKOUT	TEXT|Page	18	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toknockout	(ALTERNATE)Knockouts	(see	previous	page)	are	a	popular	decorative	effect	made	with	offset.	Tip:	When	you	are	done	adjusting	the	letter	space,	select	them	all	and
tap	Group	to	keep	themCoach	together	from	now	on.	This	overview	of	design	space	will	have	the	newest	Cricuters	13	Cricut	Hacks	to	Start	Using	Now	to	Save	Money	13	Cricut	hacks	you	probably	didn’t	know	about	that	can	save	you	money.	To	unzip	a	file,	go	to	the	Files	app	on	your	iPhone	or	iPad,	locate	and	tapon	Downloads,	tap	and	hold	the
downloaded	ZIP	filename,	and	choose	Uncompress	from	the	drop-downmenu.	Be	sure	you	select	the	SVG	file,	not	the	ZIP	file.	TapMake	It.Step	3:	Move	Step	4:	Make	REPOSITION	ON	MATeach	object	sure	the	materialon	the	mat	by	on	your	actualtapping	and	mat	matchesdragging	to	a	new	the	placementposition.	easy	to	move	around.Tip:	If	you	have
difficulties	moving	the	letters	into	position,	it	may	be	because	SmartGuides	are	turnedon.	It	seemed	like	it	happened	overnight!	When	things	were	slower,	it	was	easy	to	cut	orders	as	they	came	in.	I	also	printed	each	page	and	laminated	it	that	way	I	can	easily	refer	back	to	it	if	I’m	unsure	about	something.	When	asked	for	ImageType,	choose	Complex
and	click	Continue.Step	3:	Click	on	the	white	background	around	Step	4:	Click	Preview	to	see	the	cut	lines	of	ERASE	BACKGROUNDyour	image	to	erase	it.	Tip:	Once	your	objects	group,	they	will	be	nested	under	a	new	line	item	in	your	Layers	panel	called	“Group.”How	to	UNGroup:	Step	2:	Tap	the	word	“Group”	in	the	Layers	Step	1:	To	ungroup,
panel	to	select	it,	tap	the	Layers	button	then	tap	the	Actions	in	the	bottom	toolbar	button	and	tap	the	and	look	for	the	Ungroup	button.	Sometimes	projects	and	uploaded	imageswill	be	grouped	when	you	open/insert	them,	and	you’ll	need	to	ungroup	them	so	you	can	make	changes.How	to	Group:	Step	2:	With	all	objects	you	want	Step	1:	Tap	Layers	to
be	in	a	group	and	select	each	selected	(layers	turn	layer	you	want	to	gray	when	they	are	group	together.	and	Makesr	only).	the	Layers	panel.Once	your	images	weld,	they	will	Note:	You	can	unweld	ONLY	if	it	is	the	currentchange	to	the	same	color	and	a	new	project	on	your	Canvas	and	you	recently	weldedimage	appears	in	the	Layers	panel.	When
done,	tapApply.Note	that	you	cannot	set	pattern	fills	in	the	iOS	version	of	Cricut	Design	Space.	Is	it	down?	Here’s	how	to	resize	a	project:Step	3:	Be	sure	The	entire	RESIZE	A	PROJECTthe	lock	icon	selectedindicates	it	is	image(s)	islocked,	then	resized	andtap	the	Width	retains	itsor	Height	circles	proportions.and	tap	on	thenumber	pad	toenter	the
propersize.	If	you	keep	slicing,	you	can	make	some	pretty	amazing	designs!Step	1:	Insert	Step	2:	Tap	andyour	images	onto	drag	a	selection	boxyour	Canvas	so	around	all	of	thethat	they	are	images	you	want	tooverlapping.	If	you	don’t	see	the	font	you	know	isthere,	uncheck	the	“Only	Kerned	Fonts”	box	tosee	ALL	fonts	available.	If	it	looks	good,
clickseveral	areas	to	get	it	all.	If	you	see	it,	the	project	is	saved	for	Offline.	Tap	Make	It.Step	3:	Make	sure	Step	4:	Check	thethe	score	line	is	on	necessary	tools.	circle	above	the	Linetype	option.Step	3:	Select	Your	object	CHANGE	COLORS(tap)	the	color	changes	toyou	want.	iOS	version.Tap	Draw	Tap	Score	Tap	Engravethen	then	Apply	then
ApplyApply	to	set	a	layer	to	set	a	layerto	set	a	score	with	to	use	thelayer	to	the	Stylus	Engravingwrite	with	(Maker	or	Tool	(Makerpens	and	Explore)	only).markers.	tap	Save.	step	7,	SCORE	(STYLUS/WHEEL)use	a	thenscoring	press	thewheel	flashingbut	you	icon	ondo	not	yourhave	one,	Cricut.tap	EditTools.	Sometimes	projects	and	uploaded
imageswill	be	grouped	when	you	open/insert	them,	and	you’ll	need	to	ungroup	them	so	you	can	make	changes.How	to	Group:	Step	2:	With	all	objects	you	want	to	be	in	a	group	selected,	click	the	Group	Step	1:	Select	each	layer	in	the	Layers	panel	you	button	at	the	top	of	the	Layers	panel.	tap	Send	to	Printer.	selecting	it	and	clicking	Insert	Image.
Weld.	appears	above	and	to	the	right	of	the	selection	itself.)To	determine	if	the	sizing	is	right,	compare	it	to	the	sizing	in	the	original	instructions	or	tutorial.	That's	right	—	future	updates	to	the	Playbook	are	free	of	charge	to	purchasers!ALSO,	if	you	have	idea	for	new	pages,	let	me	know	--	if	I	get	enough	requests,	I'll	add	them	and	you	get	access	to
the	updated	file.The	Cricut	Coach	Playbook	will	save	you	TONS	of	time	AND	you'll	be	able	to	make	even	more	amazing	things	than	before.It's	like	having	a	Cricut	expert	in	your	pocket!I	absolutely	loved	everything	in	this	playbook.	Practice	this	at	Page	25	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	mirror	and	MIRROR	IRON-ON
VINYL	cut	iron	on	vinylWant	to	make	a	T-shirt	or	bag	with	iron-on	vinyl?	TapBold.	Sot	let's	get	started.	Continue.Step	5:	Decide	if	you	want	to	save	it	as	a	Print	Step	6:	Once	saved,	you	can	use	the	image	byThen	Cut,	or	just	a	Cut	Image,	then	click	Save.	Sans	or	style	ofStep	4:	Tap	Cricut	the	font.Linetype.	Practice	this	at	|Page	55	Copyright
JenniferMaker®Cricut®	Coach	Playbook	How	to	change	LETTER	SPACE	letter	spaceStep	1:	Step	2:	Select	theTap	the	text,	tap	Edit,	tapText	tool,	Letter	Space,	andchoose	a	tap	the	minus	signfont,	and	until	the	letters	looktype	something	better.onto	the	Canvas.Note	how	theletters	are	spacedwidely	apart.	You	will	not	lose	access	to	install.	tap
hereThen	tap	the	Categories	menu	and	choose	eitherMy	Projects	in	the	Cloud	or	My	Projects	on	thisiPhone	(or	iPad).To	share	a	project,	click	on	a	savedproject	then	tap	the	Share	button	onthe	left	side	of	the	window.Note:	Projects	with	images	or	fonts	that	must	bepurchased	to	use	cannot	be	saved	to	your	iPhoneor	iPad	without	first	purchasing	them.
measures	over	23.5″	(either	wide	or	high)	down	to	23.5″	on	its	longest	side,	and	there	is	no	notification	that	an	image	was	resized.	moving.To	see	what	new	features	are	available	to	you,	go	to	the	menu	in	the	upper	left	and	choose	What’s	New	UPDATE	APP	(MAC)or	go	to	jennifermaker.com/cricut-release-notes.|Page	42	Copyright
JenniferMaker®Cricut®	Coach	Playbook	How	to	GETNEW	UPDATES	on	PCCricut	Design	Space	updates	often	and	changes	are	rolled	out	to	Tip:	To	check	the	version,	hovergroups	of	users	in	phases	rather	than	all	at	once	to	make	sure	over	the	Design	Space	icon	in	thethe	updates	go	smoothly.	and	press	the	flashing	button	on	your	Cricut	cutting
machine.	If	you	need	to	set	patternfills,	use	a	desktop	or	laptop	to	access	Cricut	Design	Space	and	see	directions	on	page	21.	If	you	do	you	can	go	tonot	see	it	listed,	the	Cricut	Designmake	sure	your	Space	app	andCricut	is	turned	send	projectson	and	no	to	your	Cricutother	Bluetooth	machine.device	isconnecting	to	it.	or	rotary	(Makers	only)
blades.Change	your	operation	to	Wavy	Change	your	operation	to	Pen	Change	your	operation	to	Foil	toto	use	the	Wavy	Edge	Tool	or	to	to	write	with	pens	and	markers.	to	change).	lines	up	with	the	match	the	curve	you	circle	below.	and	upgrade	if	not.	If	so,	Slice	is	the	tool	for	you!	Slice	lets	you	cut	out	parts	of	another	object.	If	you’re	not	surewhere
you’ve	saved	it,tap	Save	As.Step	3:	If	successful,	Step	4:	To	view	yourDesign	Space	tells	you	projects	saved	forthat	your	project	was	offline,	tap	the	leftsaved.	Make	sure	you	Step	3:	Wait	for	Cricut	Design	Step	4:	Tap	Open	to	launchhave	a	good	Internet	signal	for	the	Space	to	update,	usually	no	the	updated	version	of	thebest	results.	choose	the	color
and	thickness.	Note:	If	you	don’t	see	any	of	your	saved	projects,Step	3:	If	it	may	be	because	you’re	not	signed	in.	PerforationDebossing	Blade	ToolTool	(Maker(Maker	only).only).	words	readable.	Note	that	attached	layers	will	take	on	the	same	color.	The	Contour	tool	is	a	great	way	to	modify	pre-existing	designs	to	meet	your	personal	needs!CoachStep
3:	Elements	Step	4:	Confirmthat	appear	darker	that	your	imageare	those	that	you’ll	looks	the	waykeep.	original	save.Step	3:	Give	the	If	Cricut	is	able	toproject	a	name	and	save	your	project,	atap	Save	to	the	Cloud	confirmation	window	willif	you	want	to	access	appear.it	elsewhere,	or	Saveto	Phone	(or	Save	toiPad)	if	you	want	itonly	on	this	device.To
view	your	Saved	Projects,	tap	theleft	panel	in	the	three-panel	icon,then	tap	Home.	Make	sure	you	Step	5:	Tap	Sign	In	(if	you	Step	6:	Enter	your	Cricuthave	a	good	Internet	signal	for	the	already	have	an	account).	When	done	editing,	click	Save.Step	5:	Click	either	Facebook	or	Pinterest,	If	you	share	a	link	with	uploaded	images,	this	isthen	simply	click
Copy	Project	Link.	|Page	48	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	ATTACHto	keep	things	togetherDid	you	tap	Make	It	and	find	all	of	your	elements	re-ordered	and	out	of	place?	Tap	Make	It.Step	4:	Place	Step	5:	Step	6:	SNAPMATyour	material	Look	at	Tap	andon	a	mat	and	the	photo	dragplace	the	mat	taken.	In	this	case,	you	can
click	the	Undo	button	until	you	unweld	the	image(s).	Alternatively,	you	can	click	and	drag	a	rectangle	to	select	objects.How	to	UNGroup:	Tip:	Once	your	objects	group,	they	will	be	nested	under	a	new	line	item	in	your	Layers	Step	1:	To	ungroup,	start	by	looking	for	the	word	panel	called	“Group.”	Group	in	your	layers	panel	and	click	it.	Note	that	they
may	ask	for	photos	ofwith	Cricut	Design	Space.	OPEN	&	START	PROJECT|Page	80	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	open	and	start	a	new	projectStep	1:	Tap	the	Step	2:	TapCricut	Design	icon	the	Newon	your	device.	only)	blades.Selection,	Tap	Score	You	cannotthen	then	Apply	use	the	knifetap	your	to	set	a	layer	blade
withCricut.	keep	it	in	line.	Originally,	I	tried	to	cut	all	orders	in	the	How	To	Edit	Text	in	Cricut	Design	Space	This	tutorial	covers	many	text	editing	options	in	Cricut	Design	Space.	Follow	thedirections	below	to	install	it	on	your	PC.Step	1:	Download	the	installer	at	Step	2:	Open	the	downloaded	Step	3:	Once	installed,	Cricutdesign.cricut.com	file	and
wait	for	it	to	install	Design	Space	will	automatically	onto	your	hard	drive.	|Page	7	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	connect	a	Pcto	cricut	via	bluetoothStep	1:	Open	the	Control	Panel	app.	Practice	this	at	|Page	100	Copyright	JenniferMaker®	Cricut	Sans	or	Cricut	Alphabet	font),	click	theNote	that	some	may	have	a	fee,	like
this:	Style	menu,	choose	Writing,	and	type	some	text.	Next.	Here’s	how	youcan	download	the	latest	version	of	the	Cricut	app:Step	1:	Download	the	installer	at	Step	2:	Open	the	downloaded	Step	3:	Click	Replace	whendesign.cricut.com	file	and	drag	(click,	hold,	&	move)	you	are	asked	if	you	want	to	the	Cricut	icon	over	the	folder,	replace	it	with	the	one
you	are	then	let	go	of	the	mouse.	Here’s	how	you	set	pattern	fills:Step	1:	Select	the	layer	you	want	to	change,	then	Step	2:	Click	the	Fill	menu	and	change	the	Printclick	Operation	and	change	it	to	Print	Then	Cut.	Sometimes,	a	project	or	image	set	has	multiple	groups.	Practice	this	at	|Page	88	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to
align	anddistribute	objectsStep	1:	Add	two	or	more	Step	2:	Tap	and	drag	aitems	to	your	canvas	selection	box	aroundthat	you	want	to	align	or	all	items	you	want	todistribute	evenly.	So	if	you	want	to	attach	and	have	an	issue,	look	for	ALL	groups	and	ungroup	them	first.Coach	Practice	this	at	|Page	84	Copyright	JenniferMaker®Cricut®	Coach	Playbook
How	to	WELDNeed	to	join	elements	to	create	a	new	image?	Use	Contour	to	remove	existing	parts	from	projects.Step	1:	Choose	an	image	with	Step	2:	Click	on	the	elements	you	want	toelements	you’d	like	to	remove	then	remove.	tools,	if	you	wish,	then	click	Continue.Step	7:	Choose	Print	Then	Cut	or	Cut	Image,	type	Once	inserted,	your	image	appears
in	Cricut	Designa	name,	and	click	Continue.	project.	button.	back	down	to	the	right	size.Another	thing	that	can	happen	with	text	is	that	letter	centers	(the	interior	white	space)	can	disappearwhen	you	cut	them	out.	Youcan	print	at	home,	or	you	can	take	the	fileto	a	print	shop	or	office	supply	store—a	printrelease	form	is	provided	in	the	back	of	thebook
for	your	convenience.If	you	have	any	questions	about	using	the	Playbook,email	me	at	[email	protected]For	more	Cricut	ideas	and	inspiration,	join	me	Key	to	Playbook	Pages:at	Steps	are	in	greenHappy	making,	Tips	are	in	blue	Notes	are	in	yellowJennif	er	Warnings	are	in	pinkISBN:	978-1-64737-000-8	-	version	5.4	-	updated	June	2021Cricut®	Coach
Playbook	is	copyright	2018-2021	by	JenniferMaker®	LLC.	It	is	very	easily	broken	out	so	that	way	I	don’t	have	to	keep	searching	for	answers.	device	closer	to	router.	Here’s	how	to	mirror	your	image	and	position	the	vinylon	your	mat	for	iron-on	(heat	transfer)	vinyl!Step	1:	Select	all	the	objects	you	want	Step	2:	Click	Make	It.to	iron-on	and	click
Attach.Step	3:	Toggle	Mirror	to	the	on	position,	verify	Step	4:	Connect	to	your	Cricut	and	clickyour	image	is	now	mirrored,	and	click	Continue.	do	not	want,	then	you’re	good	to	go!Slice	Tips:	SLICE•	You	can	Slice	both	images	and	text.•	You	can	only	Slice	with	two	layers.	Cloud,	then	tap	not	just	General.	Yes	No	No	Have	fun	and	make	Are	you	still
having	problems?	See	my	blog	post	at	WRITE	WITH	A	PEN	jennifermaker.com/	cricut-writing	for	more	tips	on	writing	on	your	Cricut!	I	also	have	a	free	writing	font	you	can	use	at	jennifermaker.com/	writing-font	Practice	this	at	Page	23	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	score	with	stylus	or	wheelStep	1:	Open	or	create	a
project	with	score	Step	2:	Make	sure	any	lines	you	want	to	belines.	•	Layers	in	groups	can	be	sliced	if	you	select	just	the	individual	layers,	not	the	entire	groups.	But	beware,	there	isCoach	no	Unweld	button	(only	Undo).	If	no	sizingis	provided,	you’ll	have	to	use	your	best	judgment.	Practice	this	at	|Page	98	Copyright	JenniferMaker®Cricut®	Coach
Playbook	How	to	mirror	and	cut	iron	on	vinylWant	to	make	a	T-shirt	or	bag	with	iron-on	vinyl?	Engravingmarkers.	Space,	ready	to	be	inserted	on	your	canvas!	Practice	this	at	Page	35	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	erase	abackground	from	an	imageStep	1:	Find	or	upload	a	JPG,	PNG,	GIF,	or	BMP	Step	2:	Click	the	Select	&
Erase	tool	.file	that	you	want	to	use.	Use	Attach	to	hold	your	cuts	in	the	sameposition	relative	to	each	other	on	the	cutting	mat.	Type	to	Pattern.Step	3:	Select	(click)	a	pattern	from	the	list.	You	can	add	a	score	line	to	any	project	by	scored	are	identified	as	“Score”	(click	theclicking	Shapes,	then	selecting	Score	Line.	Here’s	how	to	identify	which	fonts
willkern	for	you	automatically	and	what	to	do	when	you	need	to	fix	a	font	that	is	not	kerned.Step	1:	Click	Text,	choose	a	font,	Step	2:	Type	your	text	and	see	it	kerned!confirm	that	Only	Kerned	Fonts	is	Compare	the	kerned	line	(top)	with	a	line	that	ischecked,	then	choose	on	a	font.	box,	then	save	the	snipping	to	your	hard	drive.Step	7:	Return	to
Design	Space,	Step	8:	Select	Simple	as	Step	9:	Insert	the	knockout	oncancel	everything	until	you’re	your	image	type,	Erase	the	your	canvas,	resize	it	to	matchback	to	your	Canvas,	then	background,	and	click	Continue.	You	can	do	this	if	you	reposition	items	on	your	mat	before	you	cut!	Here’show	to	do	it	on	an	Android	device:Step	1:	Open	or	Step	2:
Makecreate	a	project.	Learn	how	to	make	a	monogram,	how	to	curve	text,	how	to	make	a	stencil	and	many	more	tips.	account	emailIf	you	already	and	password.have	Cricut	Note:	If	thisDesign	Space	is	your	firstinstalled,	you’ll	time	usingsee	a	blue	Open	Designbutton	to	tap.	out	evenly.Step	5:	Tap	on	the	Step	6:	Note	that	allEdit	tool	in	the	the	hearts
are	now	inbottom	toolbar,	tap	a	perfect	row	with	thethe	Distribute	tool,	same	spacing.and	choose	DistributeVertically.	Practice	this	at	and	|Page	57	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	knockout	textKnockouts	are	a	popular	decorative	effect.	Cut	By	Color	–	Organize	Your	Orders	–	FREE	Printables	If	your	home	based	vinyl
business	is	suddenly	taking	off,	you	may	find	yourself	struggling	to	stay	organized.	description,	and	at	least	one	photo.	Here’s	how	to	do	it:Step	1:	Click	the	menu	in	the	upper	left,	choose	Step	2:	Click	on	My	Projects,	find	a	project,Settings,	and	select	Cloud	&	Computer.	Practice	this	at	Page	15	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How
to	KERN	&	Change	letter	spaceKerning	is	when	a	font’s	letters	are	arranged	in	a	pleasing	way	rather	than	spaced	oddly.	hide	it.	Adjust	lettering	hide	it.	pressure,	but	you	can	change	CUSTOM	MATERIALS	how	many	times	it	cuts,	too.Step	7:	Step	8:	Step	9:If	you	want	Change	the	Set	yourto	create	settings	dial	toan	entirely	here	as	Customcustom
needed,	(Joys	andmaterial,	then	tap	Makers	aretap	+,	type	Save.	Practice	this	at	|Page	95	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	set	text	to	write	with	a	penYou	can	insert	a	Cricut	pen	or	marker	into	any	Cricut	Joy,	Explore,	or	Maker	machine	and	have	it	drawfor	you!	Many	crafters	like	to	use	this	feature	with	a	writing	font	to
mimic	handwriting.	You	on	Customa	name	for	may	need	by	default),it,	then	to	test	and	thentap	Add.	However,	if	you	ungroup	text	from	its	shadow	layer,	it	becomes	an	image	and	will	no	longer	work	with	the	Slice	tool	unless	the	text	is	ungrouped	to	individual	letters.	onto	your	canvas.	word	“Group.”	(Hint:	There	may	be	more	than	one!)	You	often
need	to	ungroup	before	you	can	attach	objects.	Sometimes	when	you	weld,	the	centers	fill	in—here’s	how	to	fix	that:Step	1:	Tap	Step	2:	If	you	Step	3:	Repeat	step	2	until	youText,	type	in	get	a	center	can	weld	and	the	letter	centerscript	text,	filling	in	(like	does	not	fill	in	(you	may	havechange	your	the	p	here),	to	get	REALLY	big),	then	resizeletter
spacing	tap	Undo,	back	down	to	the	right	size.so	the	letters	then	useoverlap	a	bit	the	Resize(see	page	handle	to56),	select	make	yourall,	then	tap	text	MUCHActions	>	larger,	thenWeld.	You	will	only	see	the	Makers’	operation	choices	ifyou’ve	set	your	machine	to	Maker	or	Maker	3.	(Hint:	There	select	it,	then	tap	may	be	more	than	the	Actions	button
one!)	and	tap	the	Ungroup	button.	Note	that	you	will	not	see	the	folder	in	step	4	unless	you	do	this	first.Be	sure	you	are	running	Step	1:	Step	2:	Step	3:iOS	11	or	later	on	your	Tap	New	Project	Tap	Upload	Tap	Browse	Filesdevice	(check	in	Set-tings	>	General	>	Soft-ware	Updates).	When	it,	tapit	is	centered,	Retake.the	app	willtake	a	photo	Step	8:
When	ready,automatically.	When	selected,	it	Operation	menu	and	click	a	new	color.	Here’s	how	to	mirror	your	image	and	position	your	vinylon	your	mat	for	iron-on	(heat	transfer)	vinyl!Step	1:	Step	2:	Step	3:Select	all	Tap	Tap	thethe	objects	Make	It.	Mat	iconyou	want	in	theto	iron-on,	uppertap	Actions,	leftthen	tap	cornerAttach.	both	layers,	and	tap
Actions	>	Slice.Step	10:	Delete	the	three	sliced	layers	(leaving	themain	word	layer),	tap	and	drag	the	accent	word	insidethe	empty	space	sliced	out	of	the	main	word,	with	theaccent	word	selected	tap	Edit	>	Fill	menu	and	changeit	to	No	Fill,	tap	the	color	box	to	change	the	accentword	color	if	desired,	and	tap	Make	It!	Practice	this	at	|Page	58
Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	thefont	for	existing	textStep	1:	Open	your	Step	2:	Tap	theproject	and	tap	Edit	button	at	thethe	text	you	want	bottom.to	change	the	fontfor.	If	you	do	not,	click	the	three	dots.Step	3:	In	the	panel	that	appears,	click	Save	Confirmation	that	your	project	saved	succesfullyfor	Offline.
Practice	this	at	|Page	75	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	resize	a	projectHave	you	ever	uploaded	an	SVG	design,	cut	it	out,	and	realized	it	was	too	small	or	too	big?	Practice	this	at	|Page	61	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	set	text	to	write	with	a	penYou	can	insert	a	Cricut	pen	or	marker	into	any
Cricut	Explore	or	Maker	machine	and	have	it	draw	with	it,and	many	crafters	like	to	use	this	feature	with	a	writing	font	to	mimic	handwriting.	UPDATE	APP	(IOS)Step	2:	Tap	Update.	If	your	Cricut	needsto	use	a	Wireless	Bluetooth	Adapter	(Explore	andExplore	One),	make	sure	it	is	inserted.Step	3:	If	Bluetooth	is	off,	click	Turn	Bluetooth	On.	Step	4:
Locate	a	device	that	starts	with	“Cricut”	and	click	Connect	or	Pair.	is	off,	then	lookIf	you	need	to	for	your	Cricutuse	a	Wireless	in	this	list	andBluetooth	tap	it.	Make	sure	confirmation	noticeyou	are	near	your	will	appear	at	theWi-Fi	source	for	the	bottom.best	results.	the	cartridges	to	do	this.Link	digital	cartridges	at	that	you	cannot	link	physical
cartridges	on	iOS	or	Android	devices	at	this	time.|Page	31	Copyright	JenniferMaker®Cricut®	Coach	Playbook	FLATTEN	AN	IMAGE	How	to	flatten	an	imageNeed	to	make	a	Print	Then	Cut	project?	Photos.Step	4:	Step	5:	Step	6:Open	the	Follow	Insert	theproject	previous	newlyto	which	pages	to	uploadedyou	want	upload	the	imageto	add	image	from
onto	youryour	other	step	3	and	Canvasproject.	Tip:	You	can	modify	your	template	at	any	time	by	clicking	on	the	template	name	in	the	bottom	right	corner	of	your	screen.	You	can	also	find	System	Preferences	by	clicking	on	the	Apple	menu	in	the	upper	left	corner	and	choosing	System	Preferences.Note:	Your	Cricut	must	be	within	10-15	feet	ofyour
Mac	to	connect	with	it.	If	you	no	longer	want	to	view	the	template,	click	the	eye	icon	to	hide	it.	It’s	not	currently	possible	to	do	them	completely	withinDesign	Space,	but	here	is	a	workaround	until	the	day	that	(hopefully)	this	feature	is	added:Step	1:	Tap	Step	2:	Tap	Step	3:	TapText,	type	Text	again,	the	accentyour	main	type	an	layer	andword	in	a
accent	word	resize	it	tobold	chunky	in	script	font	be	aboutfont	like	(i.e.,	I	Love	half	the	sizeCricut	Sans	Glitter).	Nowtap	Action,	tap	these	words	areAdvanced,	then	tap	properly	spaced.Ungroup	to	Letters.	Thethe	rainbow—I	added	that	so	we	slider	allows	you	to	adjust	thecould	compare	the	curve	to	it.)	curve	up	or	down.	You	can	Step	2:	Type	a	name
for	your	project,tell	if	something	is	unsaved	if	an	asterisk	*	appears	check	any	collections	you’d	like	to	add	it	tonext	to	the	name	at	the	top	of	the	window.	Yes	NoContact	Cricut	Member	Care	at	.	go!	Slice	Tips:	•	You	can	slice	both	images	and	text.	Yes	No	TROUBLESHOOTINGKeep	the	app	with	Design	Yes	No	Connect	to	Internet	&	Having	different
problems?Space	open	and	don’t	move	your	Cricut	and	Here	are	more	solutions:move	away	while	cutting.	If	you	have	multiple	images	you	want	to	SliceCoach	out	of	another,	use	the	Weld	tool	on	the	multiple	images	first.	want	to	group	together.	Unlock	Glitter).	(Note:	You	cannot	use	the	Knife	or	FoilTransfer	tools	with	the	iOS	app.)	Here’s	how	to	set
your	machine	and	change	the	linetype.Step	1:	Step	2:	Tap	Cut	thenTap	the	Tap	a	Apply	tocircle	layer,	use	the	finemenu	in	then	tap	point,	deepthe	upper	Edit,	cut,	fabric,	orleft,	tap	then	tap	rotary	(MakerMachine	Linetype.	and	look	for	the	Offline	icon.	Locate	the	weld	layer	with	the	text,	right-click	on	the	layer	name,	and	choose	Image	Info	at	the	very
bottom.	appropriate	cut	layer	in	order	for	them	to	score	on	the	right	layer,	as	shown	below.Note	that	attached	layers	will	take	on	the	same	Tip:	Layers	may	change	or	re-arrange	whencolor.	If	the	color	youyou	don’t	see	selected!the	color	youwant,	you	canchoose	anycustom	color	inthe	color	pickerbelow	it.	For	example,	to	make	a	monogrammed
pumpkin,	I	will	choose	Jack-O’-Lanterns.Step	3:	Immediately,	choose	a	style	and/or	size	Step	4:	Click	the	lock	icon	to	unlock	it,	then	type	infrom	the	drop-down	menus	at	the	top.	virtual	mat,	thenYou	can	also	tap	Continue.move	and	hide	bytapping	thethree	dots.	download	&	install.Step	4:	Tap	Open.	Cricutwhich	Designdevice	Spaceyou	and	yourhave.
only	those	two	layers),	In	this	image,	I	moved	the	and	click	Slice.	tap	Insert.	Tip:	You	can	edit	the	scale,	rotation,	and	orientation	of	the	pattern	by	clicking	Edit	Pattern	and	making	changes!	Practice	this	at	https:jennifermaker.com/sunflower-colors|Page	21	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	OPERATION	&	TOOLS
OPERATION	and	toolsThe	Operation	menu	lets	you	change	a	layer’s	type.	high)	down	to	23.5″	on	its	longest	side,	and	there	is	no	notification	that	an	image	was	resized.	Cutting	problems:Close	any	other	apps	running	on	your	Yes	No	Check	my	ideas	atdevice.	and	Makers	only).Change	your	operation	to	Score	Change	your	operation	to	Change	your
operation	to	Printto	score	with	the	Stylus	(Makers	Deboss	to	use	the	Debossing	Then	Cut	Standard	to	use	theor	Explores)	or	Scoring	Wheel	Tool,	or	to	Engrave	to	use	the	Print	Then	Cut	feature	(ExploresTools	(Makers	only).	When	your	you	want	it.image	looks	the	way	If	you	needyou	want	it	to,	click	to	make	morethe	X	icon	in	the	changes,	justupper
right	hand	click	the	Hidecorner	to	return	to	Contour	toolyour	canvas.	information	first.	How	you	icon,do	a	hard	reset	depends	on	searchyour	iPhone	or	iPad	model.	|Page	77	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	update	the	cricut	app	in	IOSStep	1:	Open	your	Cricut	Design	Alternatively,	you	can	go	to	the	Once	in	the	App	Store,
tapSpace	app.	Here’s	how	to	use	it:Step	1:	Open	Step	2:	Step	3:the	Cricut	Insert	Tap	theDesign	Space	images	or	SnapMatapp	and	tap	a	project	icon.New	Project.	score	with	the	AndroidTap	Draw	the	Stylus	version	ofthen	4	(Maker	or	Tap	Engraveto	set	a	Explore)	then	4	tolayer	to	or	Scoring	set	a	layerwrite	with	Wheel	Tools	to	use	thepens	and	(Maker
only).	Connections,Note:	Your	Cricut	Tap	Bluetooth,must	be	within	and	turn	on10-15	feet	of	Bluetooth	if	ityour	device.	Click	Make	It.Step	3:	Move	each	object	on	the	mat	by	clicking,	Step	4:	Make	sure	the	material	on	your	actual	mat	REPOSITION	ON	MATholding	down	the	mouse,	and	dragging	to	a	new	matches	the	placement	on	this	mat	preview,
thenposition.	the	New	Project	buttonTip:	If	this	is	your	Note:	If	youfirst	time	using	see	an	emptyCricut	on	your	circle	in	thedevice,	you’ll	upper	leftneed	to	install	corner,	thatit	first.	You	canyou	see	this	get	signed	out	when	you	update	your	app,	too!message,	it	You	willmeans	you	left	get	a	newsomething	on	canvas,	readyyour	canvas	the	for	you	tolast
time	you	add	images,used	the	app.	And	--	great	news	--	the	Playbook	stays	up-to-date!And	--	BONUS	--	if	there	is	a	Cricut	Design	Space	update,	or	a	new	feature	comes	out,	you	can	re-download	the	updated	Playbook	to	get	all	the	new	stuff.	Note:	If	this	is	your	first	time	using	Design	Space,	click	here	to	create	a	free	account.Tip:	If	you	are	completely
new	INSTALL	DESIGN	SPACE	(MAC)to	Cricut,	go	to	cricut.com/setupand	you	will	be	guided	through	awelcome	sequence	to	cut	your	firstproject.	Step	5:	Click	Upload	Step	6:	To	use	your	SVG,	select	the	image	you	just	uploaded	then	click	Insert	Images	Once	inserted,	UPLOAD	SVG	FILES	(PC)	your	image	appears	on	your	canvas,	ready	to	be	modified
and	or	made!	Practice	this	at	|Page	39	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toresize	a	projectHave	you	ever	uploaded	an	SVG	design,	cut	it	out,	and	realized	it	was	too	small	or	too	big?	|Page	45	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	open	and	start	a	new	projectStep	1:	Tap	the	Step	2:	Sign	inCricut	Design	icon
and	tapon	your	device.	Operation	menu	to	change)	and	are	also	attached	to	the	cut	layer	you	want	to	score.	not	have	one,	tap	Edit	Tools.Step	5:	Step	6:	Insert	the	ScoringTap	on	the	scoring	tool	that	stylusscoring	matches	step	5,tool	of	then	click	the	Scoringpreference,	flashing	icon	on	Wheelthen	tap	your	Cricut.Continue.	Check	my	mat	tips	at	sure
your	Cricut	is	actually	Yes	No	mat-tipsconnected	via	USB	or	Bluetooth.	Now	you	have	the	link!Note:	The	URL	for	these	projects	will	look	something	like	this:	|Page	69	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	flattenNeed	to	make	a	Print	Then	Cut	project?	Now	let’s	space	them	evenly.Step	5:	Click	the	Align	tool	again	and	this	time
Step	6:	Note	that	all	the	hearts	are	now	in	achoose	Distribute	Horizontally.	Ifthen	they	are,tapping	skip	toLine.	If	youlike	to	remove	want	to	removethen	tap	Actions,	all	elementsthen	tap	the	Hide	(contours),	tap	theContour	tool	in	Hide	Contours	link.the	lower	rightcorner	of	the	appwindow.	Select	the	+	symbol	to	movethe	text	layer,	it	to	the	right.	To
install	CricutDesign	Space	on	your	Windows	desktop	or	laptop	computer,	go	to	and	click	theDownload	button.	Tap	Tip:	You	canMake	It.	move	objects	from	one	mat	to	another	by	tapping	the	three	dots	and	tapping	Move	to	another	mat.Step	3:	Move	Step	4:	Make	REPOSITION	MATeach	object	sure	the	materialon	the	mat	by	on	your	actualtapping,
holding,	mat	matches	theand	dragging	to	placement	on	thisa	new	position.	Typically,	you	weld	script	fonts	(which	can	have	overlapping	letters)	sowords	cut	out	as	single	units.	Cutting	problems:Close	any	other	applications	running	Yes	No	Check	my	ideas	aton	your	computer.	Here’s	how	youcan	download	the	latest	version	of	the	Cricut	app:Step	1:
Download	the	installer	at	Step	2:	Open	the	downloaded	Step	3:	Open	the	update	Designdesign.cricut.com	file	to	install	it	and	give	it	time	Space.	This	overview	of	design	space	will	have	the	newest	Cricuters	Silhouette	Blade	Settings	Advertisement	Cricut	Design	Space	for	Dummies	New	to	the	Cricut	world?	on	your	Cricut!	I	also	have	a	free	writing
font	you	can	use	at	https://	jennifermaker.com/	writing-font	Practice	this	at	|Page	96	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	score	with	Stylus	or	WheelStep	1:	Open	or	Step	2:	Make	sure	anycreate	a	project	lines	you	want	to	bewith	score	lines.	Weld	is	like	permanent	glue.	So	if	you	want	to	attach	and	have	an	issue,	look	for	ALL
groups	and	ungroup	them	first.Coach	Practice	this	at	|Page	10	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	WELDNeed	to	join	elements	to	create	a	new	image?	tap	Copy	Link.	Here’s	how	to	do	it:Step	1:	Save	Step	2:	Type	in	a	namea	project	if	you	haven’t	alreadyfollowing	the	given	it	one,	then	tapdirections	on	Save	to	iPhone	orthe
previous	Save	to	iPad.page	(page	67).	Practice	this	at	|Page	29	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toshare	links	to	projectsDid	you	make	an	awesome	design	and	now	want	to	share	it?	Up.	If	it	looks	good,You	may	need	to	tap	Next.click	in	several	Step	6:	Onceareas	to	get	it	all.	material	before	you	cut.	To	share	a	project,	click	on
the	Share	button	on	the	bottom	of	its	box,	then	click	Copy	Project	Link	to	copy	the	URL	and	then	share	it	with	someone	as	a	link	or	in	an	email.	Practice	this	at	|Page	52	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	removeparts	with	contourNeed	to	erase	parts	of	an	existing	design?	areproject.	If	you’d	like	to	revisit	this,	click	the	menu
icon	in	the	upper	left	corner	and	choose	New	Machine	Setup	from	the	drop-	down	menu.|Page	6	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	connect	a	Macto	cricut	via	bluetoothStep	1:	Open	System	Preferences	in	your	Dock.	The	Explores	add	Score,	Foil,	and	Print	Then	Cut	Standard.	I	would	recommend	it	to	anyone!!!	-	Carolyn	G.	Do
it	with	the	Weld	tool!	The	Weld	tool	can	simplify	adesign,	keep	the	letters	of	a	word	connected,	and	combine	shapes	to	create	new	designs.Step	1:	Insert	any	images	you	Step	2:	Tap	and	drag	a	selection	box	around	allwant	to	weld	onto	your	Canvas.	on	theCenter	the	If	you	mat.mat	in	the	don’t	likeborder.	Cricut	Design	Space	app.|Page	78	Copyright
JenniferMaker®Cricut®	Coach	Playbook	How	to	troubleshoot	Design	Space	problemsYour	ability	and	willingness	to	troubleshoot	problems	is	a	high	factor	in	your	success	with	your	Cricut	(andreally,	most	things	in	life).	Here’s	how	to	mirror	your	image	and	position	your	vinylon	your	mat	for	iron-on	(heat	transfer)	vinyl!Step	1:	Step	2:	Step	3:Select	all
Tap	Tap	thethe	objects	Make	It.	mat	iconyou	want	in	theto	iron-on,	uppertap	Actions,	leftthen	tap	cornerAttach.	buttons).Step	4:	Go	to	Step	5:	Step	6:	Tapthe	Gallery	Return	to	the	magicapp	on	your	the	Cricut	wand	iconAndroid,	app,	tap	labeledopen	the	the	Upload	Remove.screen	shot,	icon,	andtap	the	Pencil	tap	Selecticon,	crop	it	from	Photoso	only
the	Library.knockoutwordremains,	thentap	Save.Step	7:	Step	8:	Tap	Step	9:	InsertTap	the	Save	as	cut	the	knockout,background	of	image,	type	resize	it	tothe	knockout	in	a	name,	match	yourimage	to	make	and	tap	Save.	stem	on	this	pumpkin	is	significantly	taller	than	the	one	I’m	using.	tighter	the	curve.	Here’s	how	to	do	it:The	Step	1:	Step	2:Shapes
Make	Go	tobutton	sure	all	youris	grayed	of	your	Homeout	and	projects	screen,cannot	are	saved	tapbe	to	the	Settings,tapped.	Tip:	You	can	change	the	font,	color,	size,	line	spacing,	etc.	If	you	have	multiple	images	you	want	to	Slice	out	of	another,	usethe	Weld	tool	on	the	multiple	images	first.•	Layers	in	groups	can	be	Sliced	if	you	select	just	the
individual	layers,	not	the	entire	groups.•	If	you	use	Slice	with	hidden	layers,	all	hidden	layers	will	be	removed.•	If	text	is	multi-layered	and	one	layer	is	hidden,	you	can	use	the	Slice	tool.	object.	You	will	only	see	theMaker	linetype	choices	if	you’ve	set	your	machine	to	Maker	or	Maker	3.	more	than	a	few	minutes.	tap	Next.	settings.Step	3:	Scroll
through	the	list	of	materials,	find	Step	4:	Change	your	settings	as	needed.one	you	want	to	edit,	and	click	the	Edit	button	Usually,	I	just	increase	the	pressure	with	thenext	to	it.	green	when	they	are	Alternatively,	you	selected),	tap	Actions	can	tap	and	drag	a	in	the	bottom	toolbar	rectangle	to	select	then	tap	the	Group	objects.	Project	buttonIf	you
cannotfind	it,	tap	in	theFinder	searcharea	and	searchon	“Cricut.”Tip:	If	this	is	yourfirst	time	usingCricut	on	yourdevice,	see	page80	for	details	onhow	to	install	it.Warning:	If	you	get	an	error	message	upon	opening	the	Cricut	app,	it	probablymeans	your	WiFi	connection	is	missing	or	not	strong	enough	for	Cricut	to	retrieveyour	account	information.
Practice	this	at	Page	9	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	GROUP	/	UNGROUP	group	and	ungroupGrouping	lets	you	keep	objects	together	in	your	design	but	not	necessarily	on	your	mat	(you	still	need	touse	the	Attach	function	to	keep	things	together	on	the	mat).	load	your	mat,	and	press	the	flashing	button.	If	you	want	to
remove	all	elementsclick	the	Contour	tool	in	the	lower	(contours),	click	the	Hide	All	Contours	button.right	corner	of	the	app	window.Step	3:	Elements	that	appear	darker	are	those	Step	4:	Confirm	that	your	image	looks	the	way	CONTOUR	(REMOVE	BITS)that	you’ll	keep.	Practice	this	at	Page	51	Copyright	JenniferMaker®Cricut®	Coach	Playbook
How	to	SLICE(cut	an	image	out	of	another)Want	to	cut	out	parts	or	even	make	your	own	custom	designs?	topmost	object.	it	was,	thenBold.	If	sign	in	email	and	passwordbest	results.	Save	time	and	money	by	getting	the	most	out	of	your	craft	supplies!	Siser	Heat	Transfer	Vinyl	Quick	Guide	10	Cricut	Explore	Air	Tips	&	Tricks	Here	are	10	Cricut	Explore
Air	Tips	&	Tricks	that	will	help	you	love	your	machine	even	more.	put	something	white(Yes,	that	(like	a	white	sheet)means	you	under	the	mat	forneed	to	take	better	contrast.	If	you	only	see	the	ZIP	file,	you’ll	need	to	first	decompress	the	ZIP	file	(open	it)	by	double-clicking	it	in	Windows	Explorer.	Cricut	Member	Care	is	very	helpful!	|Page	79	Copyright
JenniferMaker®Cricut®	Coach	Playbook	How	to	installCricut	Design	spaceStep	1:	Connect	your	Android	device	Step	2:	Tap	in	the	search	bar	at	Step	3:	Tap	Installto	the	Internet,	go	to	the	Home	the	top	and	type	“Cricut”	then	and	wait	for	it	toscreen,	and	tap	Play	Store.	Don’t	want	that	word	or	that	circle,	but	can’t	ungroup	or	hidea	layer?	“Offline”
indicator	stays	lit	when	offline.•	There	is	currently	no	way	to	batch	save	all	of	your	projects	for	offline.	You	Explore	3,	and	Makers	are	on	Custom	bymay	need	to	experiment	to	get	it	just	right.	The	Attach	feature	also	helps	you	affix	a	write	orscore	layer	to	a	cut	layer.Step	1:	Add	all	of	Step	2:	Tap	and	dragyour	elements	to	a	selection	box	aroundthe
Cricut	Design	all	of	the	imagesSpace	app	on	you	want	to	attachyour	iOS	device,	together,	tap	onincluding	text,	Actions	at	the	bottomSVG	designs,	of	the	screen,	thenscore	lines,	write	tap	Attach.lines,	etc.	When	done,	click	Save.Step	5:	If	you	want	to	create	an	entirely	new	Step	6:	Explore	One,	Air,	and	Air	2	machine	CUSTOM	MATERIALScustom
material,	click	Add	New	Material,	enter	owners	must	set	their	dial	to	Custom	(Joy,settings,	and	click	Save.	Clean	up	anything	Refine	any	cut	paths	Tap	the	image	on	the	you	don’t	want	&	tap	you	wish	then	tap	right,	give	it	a	name,	Next.	Store	to	check	for	updates.	panel.	combined!	Practice	this	at	and	|Page	74	Copyright	JenniferMaker®Cricut®
Coach	PlaybookHow	to	Upload	SVG	Files	on	an	iphone	or	iPadSVG	files	are	special	files	that	you	can	upload	to	Cricut	Design	Space	and	cut	beautiful	designs	from.To	use	an	SVG,	first	you	must	download	and	unzip	an	SVG	file.	Use	of	them	does	not	imply	any	affiliation	with	or	endorsement	by	them.	Are	you	still	having	problems?	in	the	Search	Box
next	to	the	around	the	words	inside	the	Start	menu.	Click	Add	Details.	The	Attach	feature	also	helps	you	affix	a	write	orscore	layer	to	a	cut	layer.Step	1:	Add	all	Step	2:	Tap	and	dragof	your	elements	a	selection	box	aroundto	the	Cricut	all	of	the	imagesDesign	Space	app	you	want	to	attachon	your	Android	together,	tap	ondevice,	including	Actions	at	the
bottomtext,	SVG	designs,	of	the	screen,	thenscore	lines,	write	tap	Attach.lines,	etc.	side	down,	insert	the	mat,	and	press	Go.	Practice	this	at	|Page	99	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	Save	workand	view	saved	projectsStep	1:	Step	2:	Give	theCreate	project	a	name	andsomething	tape	Save.and	tap	theSave	icon.You	can	tell
when	aproject	is	unsavedwhen	the	title	area	isblank.Step	3:	Give	your	If	Cricut	is	able	to	SAVE	WORK/PROJECTSdevice	time	to	save	save	your	project,	athe	project.	Practice	this	at	|Page	72	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	erase	abackground	from	an	imageStep	1:	Find	or	Step	2:	Tap	theupload	a	JPG,	Remove	tool	.PNG,
GIF,	or	BMPfile	that	you	wantto	use.Step	3:	Tap	Step	4:	Check	the	ERASE	BACKGROUNDon	the	white	cut	lines	of	thebackground	object.	scoring	tool	that	stylus	matches	step	5,	then	click	the	Scoring	flashing	icon	on	Wheel	your	Cricut.	The	Cricut	Maker	adds	Engrave,	Deboss,	Wave,	and	Perf.	blade-tipsDisconnect	your	Cricut,	restart	your	Yes
Nocomputer,	and	reconnect	your	Cricut.	Find	it	by	typing	Step	4:	If	you	get	a	pairing	request,	type	0000	“Control	Panel”	(that’s	four	zeros)	as	the	passcode	and	click	Next.	Cricut	is	turned	on	and	no	other	Bluetooth	device	is	connecting	to	it.Step	3:	If	you	Once	paired,	itget	a	pairing	will	appear	inrequest,	type	your	Bluetooth0000	(that’s	four	window
underzeros)	or	1234	Paired	Devices.as	the	passcodeand	tap	OK.	or	ScoringYou	can	Wheel	Toolschoose	(Maker	only).the	colorandthickness,too.Tap	Tap	Wave	Tap	PerfDeboss	then	Apply	to	then	Applythen	set	a	layer	to	to	set	aApply	to	use	the	Wavy	layer	toset	a	layer	Edge	Tool	use	theto	use	the	(Maker	only).	To	view	your	Saved	Projects,	tap	the	Home
link	at	the	top,	then	tap	the	All	Categories	menu	and	choose	My	Projects.	You	often	need	to	ungroup	before	you	can	attach	objects.	You	can	practice	downloading	a	file	atjennifermaker.com/svg-heart.	However,	once	I	was	getting	10	or	more	orders	per	day,	that	method	no	longer	worked	for	me.	page	on	your	cutting	mat,Print.	slider.	You	will	only
seethe	Maker	linetype	choices	if	you’ve	set	your	machine	to	Maker.	If	you	have	suggestionsfor	new	pages	in	this	Playbook,	please	emailme	at	[email	protected]If	you’d	like	to	print	this	Playbook	for	quickreference,	see	page	109	for	printing	tips.	Practice	this	at	|Page	56	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	WELD	textand	keep
letter	centersWelding	text	can	be	a	little	tricky.	Move	within	range	and	try	again.Step	3:	If	You	willyou	see	this	get	a	newmessage,	it	canvas,means	you	left	ready	forsomething	on	you	to	addyour	canvas	images,the	last	time	shapes,you	used	the	text,	andapp.	Here’s	how	tocheck	the	size	before	you	cut,	and	how	to	resize	an	entire	project.Step	1:	Insert,



upload,	or	create	an	image	on	Step	2:	Note	the	size	at	the	top	of	the	window	(it	alsoyour	canvas	in	Design	Space,	click	Select	All.	To	install	CricutDesign	Space	on	your	Mac	desktop	or	laptop	computer,	go	to	design.cricut.com	and	click	the	Downloadbutton.	saved,	you	canThe	slider	at	the	use	the	image	bybottom	controls	selecting	it	andhow	much	of	a
clicking	Insertgiven	color	you	Image.remove.	You	can	continue	to	link	other	cartridges,	view	your	cartridges,	or	close	the	window.When	a	physical	cartridge	has	been	linked	to	your	Tip:	If	you	have	issues	linking	your	cartridges,account,	the	digital	versions	of	those	images	are	contact	Cricut	Member	Care	for	assistanceactivated	on	your	account	and
the	physical	cartridge	getting	them	uploaded	to	your	Design	Spaceis	no	longer	needed	in	order	to	use	those	images	account.	tap	here•	There	is	currently	no	way	to	batch	save	all	of	your	projects	for	offline.	only)	blades.Selection,	You	cannotthen	use	the	knifetap	your	blade	with	theCricut.	Send	to	Printer.Step	5:	Select	your	printer,	Step	6:	Select	your
Material	Step	7:	Place	your	printedturn	on	Bleed,	and	click	(i.e.	Printable	Vinyl).	over	your	main	word,	select	both	layers,	and	click	Slice.Step	10:	Delete	the	three	sliced	layers	(leaving	the	KNOCKOUT	TEXT	(PC)main	layer),	click	and	drag	the	accent	word	inside	theempty	space	sliced	out	of	the	main	word,	with	theaccent	word	selected,	click	the
Operation	menu	andchange	it	to	Basic	Cut,	click	the	color	box	to	changethe	accent	word	color	if	desired,	and	click	Make	It!	Practice	this	at	|Page	19	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	thefont	for	existing	textStep	1:	Open	your	project	and	double-click	the	Step	2:	Click	the	drop-down	font	menu	in	thetext	you	want	to
change	the	font	for.	Click	the	cartridge	from	the	adapter	and	choose	whatLink	Cartridge	button	to	continue.	It’s	not	currently	possible	to	do	them	completely	withinDesign	Space	for	iOS,	but	here	is	a	workaround	until	the	day	that	(hopefully)	the	offset	feature	is	added:Step	1:	Tap	Step	2:	Tap	Step	3:	TapText,	type	Text	again,	Layers,	tapyour	main
type	an	the	mainword	in	a	accent	word	word	layerbold	chunky	in	script	font	and	tap	thefont	like	(i.e.,	I	Love	Eye	icon	toCricut	Sans	Glitter).	Tap	Update.	SCORE	(STYLUS/WHEEL)	Practice	this	at	|Page	97	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	reposition	items	on	mat	previewNeed	exact	control	over	where	items	on	your	mat	are
cut?	You	can	also	move	and	hide	by	tapping	click	Continue.the	three	dots	icon	on	an	element.	then	tap	Save.Tip:	The	printer	icon	inthe	Image	library	indicates	aprintable	image.Step	2:	Select	and	Step	3:	Make	sure	Step	4:	Connect	Step	5:	Select	Step	6:	Selectinsert	the	image	you	see	“Print	your	Cricut	(if	your	printer,	your	Material	(i.e.onto	your
Canvas,	Cut”	here,	then	necessary)	then	turn	off	Bleed	(if	Printable	Vinyl).then	tap	Make	It.	tap	Continue.	Blade	ToolTool	(Maker(Maker	only).only).	Choices	for	the	Cricut	Joy	are	Basic	Cut	(default)	andPen.	Tool	(MakerYou	can	only).choosethe	colorandthickness,too.Tap	Tap	Wave	Tap	PerfDeboss	then	4	to	then	4	tothen	4	to	set	a	layer	to	set	a	layerset
a	layer	use	the	Wavy	to	use	theto	use	the	Edge	Tool	PerforationDebossing	(Maker	only).	locked	Note	that	Cricut	DesignYou	can	also	resize	images	using	the	resize	icon	Space	will	automaticallyin	the	lower	right	corner	of	a	selection	box.	Practice	this	at	|Page	76	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	use	and	modifycustom
materials	settingsYou	can	use	and	modify	settings	for	MANY	materials	using	the	Custom	Materials	settings	in	Design	Space.Here’s	how	you	access	and	change	them:Step	1:	Step	2:	If	Step	3:Tap	your	prompted,	Scrollprofile	tap	your	throughcircle	Cricut	the	list	ofin	the	here.	Practice	this	at	and	|Page	91	Copyright	JenniferMaker®Cricut®	Coach
Playbook	How	to	knockout	textKnockouts	are	a	popular	decorative	effect.	So	if	you	ever	place	an	image	on	your	canvas	and	notice	that	one	side	measures	exactly	23.5”,	that	is	a	strong	indicator	that	your	image	has	been	resized.	If	the	screenlayer	as	the	cut,	then	click	Continue.	Practice	this	at	Page	40	Copyright	JenniferMaker®Cricut®	Coach
Playbook	How	to	use	and	modifycustom	materials	settingsYou	can	use	and	modify	settings	for	MANY	materials	using	the	Custom	Materials	settings	in	Design	Space.Here’s	how	you	access	and	change	them:Step	1:	Click	the	icon	with	three	lines	Step	2:	If	prompted,	select	your	Cricut	andin	the	upper	left	corner	and	select	click	Done.	Flatten	is	your
friend!	The	Flatten	tool	allows	you	to	turn	anyimage	into	a	single,	printable	layer	for	the	Print	then	Cut	feature.Step	1:	Add	two	or	more	itemsto	your	canvas	that	you	want	toflatten.Note:	Flatten	is	used	only	for	PrintThen	Cut.Coach	Step	2:	Tap	and	drag	a	selection	box	around	all	objects	you	want	to	flatten	to	select	all	of	them.Step	3:	Tap
FLATTENActions,	thentap	Flatten.Note	that	all	items	are	now	on	onelayer	and	now	work	only	for	PrintThen	Cut.If	you	decide	this	isn’t	whatyou	wanted	to	do,	tap	theUnflatten	button	right	away.	tap	Use.	If	you	cannot	Coach	find	the	icon	for	Cricut	Design	Space,	click	the	bottom-left	Start	button	on	your	desktop,	tap	“All	Apps”	in	the	menu	and	look	for
Cricut	Design	Space.|Page	5	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	Open	and	start	a	new	projectStep	1:	Open	Cricut	Design	Space	on	your	Desktop	by	double-clicking	its	icon	in	the	dock/taskbar	or	typedesign.cricut.com	in	your	web	browser	to	get	a	page	with	a	button	to	open	the	desktop	app.	You	can	upload	your	own	image	(see
page	38),	resize	it	as	needed	using	the	dimension	boxes	at	the	top	of	the	screen,	and	then	click	Arrange	>	Send	to	Back.	If	you	need	to	use	a	Wireless	get	a	pairingBluetooth	Adapter,	make	sure	it	is	inserted.	If	you	do	not	see	it	listed,	make	sure	your	Cricut	is	turned	on	and	no	other	Bluetooth	device	is	connecting	to	it.Step	5:	If	you	get	a	pairing
request,	type	0000	CONNECT	VIA	BLUETOOTH(that’s	four	zeros)	as	the	passcode	and	click	Pair.	Step	2:	Click	on	Add	a	Device	under	Hardware.	These	13	hacks	are	things	you	can	easily	do	and	find	the	supplies	for	around	your	house.	Let’sfix	that.Step	3:	The	letter	Step	4:	Select	just“w”	isn’t	close	the	letter	“w”	thenenough	to	the	“h”	tap	Edit,	then
tapin	the	example	H	Position,	and	taphere.	Space,	ready	to	be	inserted	on	your	canvas!	Practice	this	at	Page	34	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toUpload	Images	on	a	Pc	Step	3:	Click	Browse	Step	4:	Select	a	PNG,	JPG,	GIF,	or	BMP	and	click	OpenStep	1:	Step	2:Click	Upload	Click	Upload	ImageStep	5:	Choose	an	Image	Type	(I
recommend	Complex,	Step	6:	Clean	up	and	refine	your	image	using	the	UPLOAD	IMAGES	(PC)but	you	can	experiment)	and	click	Continue.	Practice	this	at	Page	85	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	SLICE(cut	an	image	out	of	another)Want	to	cut	out	parts	or	even	make	your	own	custom	designs?	Unlock	Adjust	letters	the
accentit,	resize	it	as	needed,	word	layer,to	make	it	unlock	it,	tap	Edit,taller,	and	resize	it,	and	tap	the	Filltap	Actions	>	tap	Actions	>	menu,	andWeld.	Practice	this	at	|Page	89	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	CHANGE	LETTER	SPACE	letter	spaceStep	1:	Step	2:	Select	theTap	the	text,	tap	Edit,	tapText	tool,	Letter
Space,	andchoose	a	tap	the	minus	signfont,	and	until	the	letters	looktype	something	better.onto	the	Canvas.Note	how	theletters	are	spacedwidely	apart.	Problems	happen,	but	you	CAN	solve	them.	easy	to	move	around.	Updates	may	happen	automatically	Taskbar	when	it’s	running.upon	launching	the	app,	or	if	the	app	is	open	when	the	update
isdetected,	you	will	be	prompted	to	update	your	application—if	this	Cricut	Design	Space	v6.10.107happens,	save	your	work	and	accept	the	update.If	you	are	ever	unsure	if	you	have	the	latest	version	of	the	app,	goto	the	Release	Notes	at	jennifermaker.com/cricut-release-notes,check	the	latest	version,	and	compare	it	to	yours.	your	mainRecents,	and
word,	selecttap	the	image.	So	be	sure	to	set	a	reminder	to	go	online	at	least	once	every	30	days.•	You	cannot	upload	anything	new	while	offline	(this	means	even	from	your	desktop	or	images	within	Design	Space).	slice,	tap	on	Actions	at	the	bottom	of	the	screen,	then	tap	Slice.After	you	tap	Step	3:	Move,Slice,	new	layers	hide,	or	deletecalled	“Slice
the	layers	you	doResult”	will	not	want,	thenappear.	computer	closer	to	router.	Alphabet).	|Page	46	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	connect	iOS	to	cricut	via	bluetoothStep	1:	Tap	the	Step	2:	TapSettings	app.	Practice	this	at	|Page	65	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	use	snapmatA	useful	feature	of
Cricut	Design	Space	on	iOS	is	SnapMat,	which	allows	you	to	take	a	photo	of	yourmaterial	on	the	mat	and	then	position	your	items	on	it.	Follow	the	directions	belowto	install	it	on	your	Mac.Step	1:	Download	the	installer	at	Step	2:	Open	the	downloaded	Step	3:	Open	your	Applicationsdesign.cricut.com	file	and	drag	(click,	hold,	&	move)	folder	and
double-click	the	Cricut	icon	over	the	folder,	the	Cricut	application	then	let	go	of	the	mouse.	not	kerned	(bottom)	to	see	the	difference!Note	that	text	in	older	projects	may	not	Kerned	fonts	are	automatically	welded	afterautomatically	be	kerned.	into	the	search	bar	at	the	bottom	of	your	window.Note:	Your	Cricut	must	be	within	10-15	feet	ofyour	PC.
New	Machine	Setup	from	the	drop-down	menu.	Insert.	upper	left	corner.Step	3:	Choose	a	new	font	from	the	list	that	Your	font	changes!appears.	at	any	time	(so	long	as	you	don’t	flatten	or	weld	it)	thanks	to	this	curve	text	feature!Coach	Practice	this	at	|Page	14	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	align	and	ALIGN	AND
DISTRIBUTEdistribute	objectsStep	1:	Add	two	or	more	items	to	your	canvas	Step	2:	Click	and	drag	a	selection	box	aroundthat	you	want	to	align	or	distribute	evenly.	to	begin	using	the	app.	I	Love	Glitter).	Here’s	how	to	resize	a	project:Step	3:	Be	sure	the	lock	icon	The	entire	selected	image(s)	is	resized	andindicates	it	is	locked,	then	type	retains	its
proportions.the	proper	size	in	either	the	W	orH	field	at	the	top	of	the	screen.	Your	post	you	the	threeproject	just	shared,	dots	in	theis	now	and	tap	upper	rightshared	to	the	Share	corner	andFacebook.	Practice	this	at	|Page	73	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	tocombine	multiple	projectsWhile	there	is	no	built-in	function	in
Design	Space	that	allows	you	to	combine	projects,	there	is	aworkaround.	the	Layers	panel.Once	your	images	weld,	they	will	Note:	You	can	unweld	ONLY	if	it	is	the	currentchange	to	the	same	color	and	a	new	project	on	your	Canvas	and	you	recently	welded	it.image	appears	in	the	Layers	panel.	If	you	doAdapter,	make	not	see	it	listed,sure	it	is	make
sure	yourinserted.	Practice	this	at	|Page	12	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	REMOVEparts	with	contourNeed	to	erase	parts	of	an	existing	design?	missing	optionsStep	6:	Step	7:	will	be	FIX	MISSING	OPTIONSDo	a	hard	reset	(force	restart)	Tap	the	back.of	your	iPad	or	iPhone.	When	you	are	done,	select	all	letters	and	click
Attach	to	cut	them	together.	click	Apply.Step	4:	Select	and	separate	the	Step	5:	Position	the	offset	layer	Step	6:	Delete	the	sliced	outnew	offset	layer,	which	you	can	over	your	main	word,	layers	by	selecting	andsee	looks	similar	to	the	accent	select	both	layers	(and	clicking	the	Delete	button.layer	but	is	thicker	and	bolder.	align	and/or	distribute.Step	3:
Tap	on	the	Edit	Step	4:	All	selected	ALIGN	AND	DISTRIBUTEtool	in	the	bottom	items	are	alignedtoolbar,	tap	Align,	and	with	the	bottommosttap	Align	Bottom.	So	only	ATTACH	THINGS	TOGETHER	attach	layers	that	you	really	want	to	be	the	same	color!	Tip:	If	you	are	having	a	problem	attaching	layers,	try	ungrouping	layers	first.You	can	verify	that
your	images	attached	Score	lines	must	be	attached	with	theby	tapping	Layers	and	noting	that	they	are	appropriate	cut	layer	in	order	for	them	tonow	labeled	“ATTACH.”	score	on	the	right	layer,	as	shown	below.	Note:	Projects	with	uploaded	images	can	be	saved	and	shared,	but	they	can	only	be	customized	and	made	by	you—others	will	not	be	able	to
open	and	make	them.	scored	are	attached	toYou	can	add	a	score	the	layer	that	shouldline	to	any	project	have	the	score	line	(tapby	tapping	Shapes,	the	arrow	on	the	layerthen	tapping	Line.	If	thethe	same	layer	as	screen	says	to	use	athe	cut,	then	tap	scoring	wheel	but	you	doContinue.	right	and	click	Continue.the	search	page	to	seeall	images	that	are
setto	free	for	anyone	touse.Step	2:	Select	and	insert	Step	3:	Make	sure	you	see	Step	4:	Select	your	Cricutthe	image	onto	your	Canvas,	“Print	Then	Cut”	here,	(if	necessary)	then	clickthen	click	Make	It.	then	click	Continue.	to	the	color	youIf	you	don’t	see	the	selected!color	you	want,you	can	choose	anycustom	color	in	thecolor	picker	belowit.	TheCricut
Explores	add	Score.	But	you	can	connect	the	spaces	and	keep	the	centers!	Here’s	how	to	fix	that:Step	1:	Tap	Step	2:	Tap	Step	3:	Tap	KEEP	LETTER	CENTERSText,	type	Shapes,	and	drag	thetext,	and	select	a	rectanglelook	for	square,	and	over	aletters	&	unlock	it	letter	withnumbers	and	resize	it	interior	whitewith	interior	so	it	forms	space	so	it’swhite
space	a	rectangle	connecting(counters),	about	the	the	spacelike	A,	B,	D,	width	of	inside	toO,	P,	Q,	R,	a,	the	letter’s	the	spaceb,	d,	e,	g,	o,	strokes.	If	your	letters	touch,	click	Weld	instead.will	Practice	this	at	Page	16	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	WELD	textand	keep	letter	centersWelding	text	can	be	a	little	tricky.	You	can
do	this	if	you	reposition	items	on	your	mat	before	you	cut!	Here’show	to	do	it	on	a	computer	(Mac	or	Windows):Step	1:	Open	or	create	a	project.	So	be	sure	to	set	a	reminder	to	go	online	at	least	once	every	30	days.•	You	cannot	upload	anything	new	while	offline	(this	means	even	from	your	iPhone/iPad	or	images	within	Design	Space).	tap	Actions,	tap
letter	so	it’s	basetext.	Note:	If	you	don’t	see	the	font	Step	4:	Adjust	the	Font	Size	and	Letter	Space	you	know	is	there,	uncheck	as	necessary	so	it	looks	the	way	you	want	it	to	the	“Only	Kerned	Fonts”	box	look,	then	click	Make	It.	to	see	ALL	fonts	available.Step	3:	Click	Operation,	select	Draw	under	Pen,then	click	the	square	to	the	right	of	Operation,and
select	a	pen	type	and	color.Step	5:	Click	and	drag	the	text	to	the	exact	spot	Step	6:	Insert	the	pen	in	your	Cricut’s	accessoryyou	want	it	to	be	written	on	your	material	on	the	clamp,	position	your	material	on	the	cutting	mat,machine	mat	(see	page	25),	then	click	Continue.	If	so,	tap	Undo	until	you	unweld	the	image(s).	tap	Continue,	chooseStep	7:	If	you
your	materials,	andhave	multiple	make	your	cuts!mats	in	yourproject,	Tip:	If	SnapMat	won’tyou’ll	need	take	a	photo	of	yourto	repeat	mat,	make	sure	you’vesteps	5-6	for	got	good	lighting	andeach	mat.	If	youicon.	You	can	eithertap	the	text	itselfon	the	canvas,	ortap	the	text	line	inthe	Layers	panel.Step	3:	Tap	the	Step	4:	Choose	aFont	Name	menu	new
font	from	thein	the	lower	left	pop-up	menu.corner.Your	font	changes!	You	can	always	see	what	font	is	used	in	a	layer	by	tapping	the	Layers	panel	and	then	tapping	the	information	button	(	)	—	this	information	is	provided	even	if	you	weld	the	font.	You	must	click	each	one	and	select	“Save	for	Offline”	individually.•	If	you	are	working	offline,	and	the
online	version	is	not	synced	up	to	the	offline	version,	the	next	time	you	go	online	a	pop-up	will	appear	asking	you	to	select	a	version	to	keep.•	Any	images	you	have	in	a	project	from	Cricut	Access	will	expire	after	30	days	if	you	do	not	go	online	at	all	during	those	30	days	(even	if	you	have	monthly	access).	Use	Contour	to	remove	existing	parts	from
projects.Step	1:	Choose	Step	2:	Tap	on	thean	image	with	elements	you	wantelements	you’d	to	remove.	(tap	each	layer	at	the	same	time	to	select	both).Step	4:	After	Step	5:Tap	you	tap	Move,Actions,	Slice,	hide,	orthen	tap	three	deleteSlice.	Space,	click	here	to	create	INSTALL	IOS	APP	a	free	account.	tappingtapping	If	not,	see	Linetype.Shapes,	step	3.
And	the	Cricut	Makers	add	to	this	severalmore	choices:	Wavy,	Perforate,	Deboss,	and	Engrave.	To	fix	this,	click	on	you	click	Make	It,	so	there	is	no	need	to	weldthe	text,	and	then	if	it	is	a	kerned	font,	it	will	manually	unless	you	ungroup	your	text.automatically	kern	the	text.If	your	font	isn’t	kerned,	here’s	how	you	can	manually	change	your	letter
spacing:Step	1:	Identify	text	that	is	not	kerned	by	how	Step	2:	Select	the	text	and	clickthe	letters	do	not	seem	to	fit	together	well,	like	the	down	arrow	in	the	Letter	Spacethis	text	below:	box	until	the	letters	look	better.Step	3:	The	letter	“w”	is	too	far	away	Step	4:	Select	just	the	letter	“w”	and	move	KERN	&	CHANGE	SPACEfrom	the	“h”	—	select	the
text	and	click	it	to	the	right,	holding	down	the	Shift	key	toAdvanced	then	click	Ungroup	to	Letters.	unhide	yourtap	Upload,	Then	tap	Cut	main	word,tap	Select	Image,	type	position	thefrom	Photo	in	a	name,	knockout	overLibrary,	tap	and	tap	Save.	and	clickCustom	the	arrowMaterials.	(If	you’re	alreadyclick	General,	and	click	“Open	Anyway”	signed	in,
you’re	logged	in	automagically.)at	the	bottom	of	the	screen.	any	SVG	file	that	measures	over	23.5″	(either	wide	orJust	click,	hold,	and	drag	to	resize.	Step	5:	Click	Upload	Step	6:	To	use	your	SVG,	select	the	image	you	just	uploaded	then	click	Insert	Images	Once	inserted,	your	image	appears	on	your	canvas,	ready	to	be	modified	and	or	made!	Practice
this	at	Page	38	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	UploadSVG	Files	on	a	PC	Step	3:	Click	Browse	Step	4:	Select	the	SVG	File	and	click	OpenStep	1:	Step	2:Click	Upload	Click	Upload	Image	Tip:	Type	a	word	or	two	as	a	tag	to	help	you	find	this	image	Notes:	later	in	a	search.	load	it,	and	click	Go.	PRINT	THEN	CUT	Practice	this
at	|Page	33	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toUpload	Images	on	a	Mac	Step	3:	Click	Browse	Step	4:	Select	a	PNG,	JPG,	GIF,	or	BMP	and	click	OpenStep	1:	Step	2:Click	Upload	Click	Upload	ImageStep	5:	Choose	an	Image	Type	(I	recommend	Step	6:	Clean	up	and	refine	your	image	using	theComplex,	but	you	can	test)	and	click
Continue.	you’re	good	to	go!Slice	Tips:•	You	can	Slice	both	images	and	text.•	Layers	in	groups	can	be	Sliced	if	you	select	just	the	individual	layers,	not	the	entire	groups.•	If	you	use	Slice	with	hidden	layers,	all	hidden	layers	will	be	removed.•	If	text	is	multi-layered	and	one	layer	is	hidden,	you	can	use	the	Slice	tool.	If	you’re	using	a	Cartridge	Adapter,
it	on	and	connected.	Step	2:	Click	the	Bluetooth	icon	to	open	it.	of	the	images	you	want	to	weld	together,	tap	on	Actions	at	the	bottom	of	the	screen,	then	tap	Weld.Note:	If	you	are	WELDtrying	to	createa	single	image	Tip:	You	can	selectwith	Weld,	items	within	groupsmake	sure	all	to	weld	by	tappingelements	are	on	their	names	inoverlapping.
selected),	tap	Actions	Alternatively,	you	in	the	bottom	toolbar	can	tap	and	drag	a	then	tap	the	Group	rectangle	to	select	button.	Machine	problems:	Check	the	Cricut	site	atAre	you	still	having	problems?	The	more	you	slide,	thetighter	the	curve.	Delete	all	Repeat	stepsStep	4:	Select	layers	except	2-5	forthe	word	and	the	layer	all	letters	asthe	rectangle,
with	the	needed.then	tap	word	in	it.Actions	>Slice.	Practice	this	at	Page	22	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	set	text	to	write	with	a	penYou	can	insert	a	Cricut	pen	or	marker	into	any	of	the	Cricut	Joys,	Explores,	or	Makers	and	have	themdraw	for	you.	Tip:	If	you	have	difficulties	moving	the	letters	into	position,	it	may	be
because	SmartGuides	are	turned	on.	default),	and	then	you	can	choose	your	custom	material	before	you	cut	out	your	project.|Page	41	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	GETNEW	UPDATES	on	MACCricut	Design	Space	updates	often	and	changes	are	rolled	out	to	Tip:	To	check	the	version,	click	thegroups	of	users	in	phases
rather	than	all	at	once	to	make	sure	Design	Space	icon	in	the	Applicationsthe	updates	go	smoothly.	When	itlooks	good,	tapNext.Step	5:	Decideif	you	wantto	save	it	as	aCut	Image	or	aPrint	Then	Cut,give	it	a	name,then	tap	Save.	Resize	the	circle	to	Advanced,	then	tap	lines	up	with	the	match	the	curve	you	Ungroup	to	Letters.	Many	crafters	like	to	use
this	feature	with	a	writing	font	to	mimic	handwriting.	perfect	row	with	the	same	spacing.	Do	it	with	the	Weld	tool!	The	Weld	tool	can	simplify	a	WELDdesign,	keep	the	letters	of	a	word	connected,	and	combine	shapes	to	create	new	designs.Step	1:	Insert	any	images	you	want	to	Step	2:	Select	all	images	to	be	weldedweld	onto	your	Canvas.	available),
and	click	Print.Step	7:	Place	your	printed	Practice	this	at	on	your	cutting	mat,load	it,	and	tap	Go.	|Page	71	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toupload	images	in	IOSStep	1:	Step	2:	Step	3:	Note:	If	you	want	toTap	New	Project	Tap	Upload	Tap	Browse	Files	or	use	the	Browse	Files	Select	from	Photo	feature,	be	sure	you	Library,
depending	on	are	running	iOS	11	or	where	you	saved	your	later	on	your	device	file.	If	so,	Slice	is	the	tool	for	you!	Slice	lets	you	SLICEcut	out	parts	of	another	object.	Advanced	to	choose	a	custom	color.You	can	also	give	objects	a	pattern	fill.	Design	Space	for	Desktop	will	allow	you	to	work	both	online	and	offline.	•	If	you	use	Slice	with	hidden	layers,
all	hidden	layers	will	be	removed.	tap	Print.Step	4:	Tap	Step	5:	Take	Step	6:	Go	toMake	It,	tap	a	screen	shot	Safari,	visitthe	Mat	Icon	of	the	Print	lunapic.com,in	the	upper	screen,	crop	tap	Upload,left,	make	it	so	you	find	yoursure	Bleed	see	only	the	image,	tapis	toggled	knockout	Transparencyon,	then	tap	text,	and	to	make	itthe	Mat	Icon	save	it	to
transparent,again.	|Page	81	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	connect	via	bluetoothStep	1:	Tap	the	Step	2:	TapSettings	app.	Give	materials,upper	left	it	some	find	onecorner	time	to	you	wantand	tap	load	your	to	edit,Manage	settings.	So	be	sure	to	save	all	images	you	want	in	a	project/canvas	before	heading	offline.	Choices	for
the	Joy	are	Cut	(default)	and	Draw.	modified	and/or	made!	Tip:	Type	a	word	or	two	as	a	tag	to	help	you	find	this	image	later	in	a	search.	You	can	so	long	as	there	are	no	uploadedimages	in	your	project.	Clickturns	a	darker	gray	in	the	Layers	panel.	You	can	tell	it	is	the	SVG	file	because	its	“Kind”	is	listed	as	“Scalable	Vector	Graphics	Image”	in	your	file
browser.	Need	a	template	but	can’t	find	it	in	the	template	library?	it	if	you	are	asked.	tool	of	scoring	ScoringIf	the	preference,	tool	that	Wheelscreen	then	tap	matchessays	to	Continue.	Check	status.cricut.comWatch	the	status	site	for	it	to	come	back.	H	Position,	and	tapSelect	the	text	and	the	+	symbol	to	movetap	Action	then	tap	it	to	the	right.	Just
double-click	the	icon	to	go	to	Cricut	Design	Space	again.	all	letters	as	needed.Practice	this	at	and	|Page	17	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toOFFSET	&	KNOCKOUT	TextOffset	and	inset	is	a	beta	feature	of	Cricut	Design	Space	that	allows	you	to	create	outlines	around	orwithin	text	and	images.	appears	at	the	top	of	the
screen.When	you	lose	Internet	access,	you	are	notified	and	Open	the	project	and	continue	working!	Theany	projects	you’ve	saved	for	offline	are	listed.	Quickly	releaseto	add	to	in	your	both	buttons.	(If	you’re	already	completely	new	tosigned	in,	you’re	logged	in	automagically.)	Cricut,	first	go	to	cricut.com/setup	and	Note:	If	this	you	will	be	guided	is
your	first	through	a	welcome	time	using	sequence	to	cut	your	Design	first	project.	not	attached,	see	page	49	for	directions	on	how	to	at-	tach	layers.Step	6:	Step	7:	Step	8:	ScoringCheck	the	Tap	on	the	Insert	stylusnecessary	scoring	thetools.	Click	NewTo	view	your	Saved	Projects,	click	Collection	to	create	a	new	category.	on	Browse	All	Materials.Step
5:	Search	for	“iron”	and	select	the	type	of	Step	6:	Place	your	iron-on	vinyl	on	your	cuttingiron-on	vinyl	you	plan	to	use,	then	click	Done.	the	space	outside,	like	this:numbers	(0,	4,	6,	8,	and	9)Step	4:	Select	the	word	and	the	Step	5:	Delete	all	layers	Repeat	steps	2-5	for	KEEP	LETTER	CENTERSrectangle,	then	click	Slice.	says	to	use	a	scoring	wheel	but
you	do	not	have	one,	click	Edit	Tools.Step	5:	Click	on	the	scoring	tool	of	preference,	Step	6:	Insert	the	Scoring	SCORE	(STYLUS	/	WHEEL)then	click	Continue.	Important:	You	will	want	to	select	all	letters	and	tap	Action	then	tap	Group	to	make	sure	your	letters	stay	together	when	you	cut	them.	objects.How	to	UNGroup:	Tip:	Once	your	objects	group,
they	will	be	nested	under	a	new	line	item	in	your	Layers	panel	called	“Group.”	Step	1:	To	ungroup,	tap	the	Layers	button	Step	2:	Tap	the	layer	in	the	bottom	toolbar	titled	Group	in	the	and	look	for	the	word	Layers	panel	to	Group.	But	you	can	connect	the	spaces	and	keep	the	centers!	Here’s	how	to	fix	that:Step	1:	Click	Text,	type	in	your	Step	2:	Click
Shapes,	select	a	Step	3:	Click	and	drag	thetext,	and	look	for	letters	with	square,	and	unlock	it	and	resize	rectangle	over	a	letter	withinterior	white	space	(counters),	it	so	it	forms	a	rectangle	about	interior	white	space	so	it’slike	these	letters	(A,	B,	D,	O,	P,	the	width	of	the	connecting	the	space	inside	toQ,	R,	a,	b,	d,	e,	g,	o,	p,	q)	and	letter’s	strokes.	I
remember	when	I	first	started	selling	on	Etsy	in	2016	--	I	went	from	getting	roughly	5	orders	a	week	up	to	dozens	of	orders	per	week.	|Page	8	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	ATTACHto	keep	things	togetherDid	you	click	Make	It	and	find	all	of	your	elements	re-ordered	and	out	of	place?	Once	found,	open	it.	request,
typeStep	3:	Turn	0000	(that’son	Bluetooth	if	four	zeros)	asit	is	off,	then	the	passcodelook	for	Cricut	and	tap	Pair.in	this	list	and	Once	connected,tap	it.	If	you	need	to	use	a	Wireless	BluetoothAdapter,	make	sure	it	is	inserted.Step	3:	Let	your	computer	look	for	your	Cricut,then	click	its	icon	and	click	Next.	Is	it	installed	and	up-to-date?Yes	Restart	your
computer.	Weld	is	permanent!	Practice	this	at	|Page	11	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	SLICE(cut	ONE	image	out	of	another)	Want	to	cut	out	parts	or	even	make	your	own	custom	designs?	|Page	20	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	changecolors	and	pattern	fillsStep	1:	Select	(click)	the	layer	you
want	to	change,	Step	2:	Click	the	square	to	the	right	of	thelike	the	center	of	this	flower.	Tap	the	thumbnailanother	design	are	of	your	screenshot	that	appearsand	turn	touching	in	the	lower-left	corner,	and	cropoff	the	grid	and	you	it	(slide	inby	tapping	need	them	the	sides)Settings	separated,	to	adjustand	toggle	move	the	design.the	Grid	them	Tap
Save	tooff.	Now	let’s	space	them	out	evenly.Step	5:	Tap	on	the	Step	6:	Note	that	allEdit	tool	in	the	the	hearts	are	now	inbottom	toolbar,	tap	a	perfect	row	with	thethe	Distribute	tool,	same	spacing.and	choose	DistributeHorizontally.	mat	shiny	side	down,	insert	the	mat,	and	press	Go.	Practice	this	at	Page	26	Copyright	JenniferMaker®Cricut®	Coach
Playbook	How	touse	a	TemplateStep	1:	Open	a	new	project	and	click	Step	2:	Choose	a	template	that	best	fits	yourthe	Templates	button	on	the	left	side.	and	change	it	to	Print	Then	Cut.Step	4:	Click	Make	It,	click	Step	5:	Open	the	Snipping	Tool	Step	6:	With	the	Snipping	ToolContinue,	click	Send	to	Printer,	by	searching	for	“snipping	tool”	open,	click
and	drag	a	boxtoggle	on	Add	Bleed.	Ifyou’ve	already	savedthis	project	before	in	theCloud	for	online	work,tap	Save	As	instead	ofSave.	For	example,	thebuttons	in	the	lower	left	corner.	Fix	this	and	keepeverything	exactly	where	you	want	with	the	Attach	button.	(If	you’re	already	signed	in,	you	will	side	or	the	New	Project	button	in	the	upperbe	taken	to
the	next	step	automagically.)	right	corner	(they	do	the	same	thing).You	will	get	a	new	canvas,	ready	for	you	to	add	Tip:	If	you	areimages,	shapes,	text,	and	projects!	completely	new	to	Cricut,	you	will	be	guided	through	a	welcome	sequence	and	your	first	project	upon	your	very	first	visit	to	this	page.	want.Step	5:	As	you	work,	Step	6:	Keep	going	Step
7:	Check	that	Step	8:	Delete	the	CURVE	TEXTrotate	the	letters	to	until	all	the	text	is	your	curves	look	circle	and	group	allmatch	the	curve	of	in	position.	|Page	94	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	LINETYPE	&	TOOLS	linetype	and	toolsThe	Linetype	menu	lets	you	change	the	tool	for	a	layer.	Note:	If	you	are	WELD
trying	to	create	a	single	image	Tip:	You	can	select	with	Weld,	items	within	groups	make	sure	all	to	weld	by	tapping	elements	are	on	their	names	in	overlapping.	If	you’d	like	to	revisit	this,click	the	menu	icon	in	the	upper	leftcorner	and	chooseNew	Machine	Setupfrom	the	drop-down	menu.|Page	4	Copyright	JenniferMaker®Cricut®	Coach	Playbook
How	to	installCricut	Design	space	(Pc)Cricut	Design	Space	is	the	free	software	you’ll	use	to	make	amazing	things	on	your	Cricut.	resize	any	SVG	file	thatJust	click,	hold,	and	drag	to	resize.	resize	it,	and	click	Weld.	However,	if	you	ungroup	textfrom	its	shadow	layer,	it	becomes	an	image	and	will	no	longer	work	with	the	Slice	tool	unless	the	text
isungrouped	to	individual	letters.	Yes	No	cutting-problems	Mat	problems:	Are	you	still	having	problems?	RESIZE	A	PROJECTYou	can	also	resize	images	using	the	resize	icon	Note	that	Cricut	Design	Space	may	automatically	resizein	the	lower	right	corner	of	a	selection	box.	of	the	screen.Step	4:	Step	5:	Step	6:Toggle	Verify	that	Tap	on	AllMirror	to
your	image	Materials.the	on	is	mirrored,position	then	tapand	tap	the	Continue.Mat	iconagain	to	MIRROR	IRON-ON	VINYLclose	thiswindow.Step	7:	Step	8:	Place	Remember,	put	the	vinylSearch	your	iron-	SHINY	SIDE	DOWN	on	youron	“Iron”	on	vinyl	on	cutting	mat!and	select	your	cuttingthe	type	mat	shinyof	iron-on	side	down,vinyl	you	load	the
mat,plan	to	use.	Practice	this	at	Page	24	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	reposition	items	on	mat	previewNeed	exact	control	over	where	items	on	your	mat	are	cut?	If	a	new	version	is	Home	screen	and	tap	the	App	the	Search	icon	and	searchavailable,	it	will	tell	you.	You	scored	are	the	Linecan	add	identified	layer,a	score	as
tappingline	to	any	“Score”	Edit,	thenproject	by	next	to	it.	and	click	Save.	CONNECT	VIA	BLUETOOTHStep	5:	Allow	your	PC	time	to	setup	the	Bluetooth	Once	paired,	it	will	appear	in	your	Devices	andconnection	to	your	Cricut.	not	the	ZIP	file.	You	may	need	to	click	in	the	object	remaining.	Practice	this	at	|Page	83	Copyright	JenniferMaker®Cricut®
Coach	Playbook	How	to	GROUP	/	UNGROUP	group	and	ungroupGrouping	lets	you	keep	objects	together	in	your	design	but	not	necessarily	on	your	mat	(you	still	need	touse	the	Attach	function	to	keep	things	together	on	the	mat).	You	can	also	change	the	color.Step	5:	Resize	your	Canvas	so	you	can	see	most	Tip:	You	may	need	to	add	or	subtract	if	the
shapeor	all	of	the	template	by	using	the	doesn’t	quite	match	your	item.	Get	fordirections	on	Google	or	at	Cricutjennifermaker.com/hardresetiphone	Designor	Space,jennifermaker.com/hardresetipad	and	tap	this	icon.	your	accent	word,	unhide	yourUpload	the	file	you	saved	(look	Then	click	Save	as	a	Cut	Image	main	word,	position	the	knockoutin	your
Downloads	directory).	CURVE	TEXTStep	3:	Slide	the	slider	to	the	right	for	a	Step	4:	Slide	the	slider	to	the	left	for	andownward	curve.	If	you	needaround	your	to	fix	it,	tap	Cleanimage	to	erase	it.	I	recommend	the	Chat	option	when	available—	you	can	also	call	during	open	hours	or	email	them	at	anytime.	Here’s	how	tocheck	the	size	before	you	cut	it
out:Step	1:	Insert,	Step	2:	Tap	Edit,upload,	or	create	then	note	the	sizean	image	on	your	at	the	bottom	of	thecanvas	in	Design	window	in	the	WidthSpace,	then	and	Height	circles.select	all	imagesyou	want	toresize	by	tappingand	dragging	aselection	boxaround	them.To	determine	if	the	sizing	is	right,	compare	it	to	the	sizing	in	the	original	instructions
or	tutorial.	Your	Mac	will	not	always	show	“Connected”	unless	Design	Space	is	communicating	with	the	Cricut	during	a	cut.Once	connected,	you	can	select	your	machinefrom	the	drop-down	menu	in	Cricut	Design	Space.	sure	the	itemsMake	anything	you	want	toyou	want	to	reposition	areappear	on	the	all	on	the	samesame	mat	the	mat.same	color.	To
do	this,	ATTACH	THINGS	TOGETHERDesign	Space,	including	text,	SVG	designs,	click	on	any	layers	called	Group	andscore	lines,	write	lines,	etc.	Step	2:	With	the	group	selected,	click	the	Ungroup	button	at	the	top	of	the	Layers	panel.	main	word,	position	the	knockout	over	KNOCKOUT	TEXT	(Android)	your	main	word,	select	both	layers,	and	tap
Actions	>	Slice.Step	10:	Delete	the	three	sliced	layers	(leaving	themain	word	layer),	tap	and	drag	the	accent	word	insidethe	empty	space	sliced	out	of	the	main	word,	with	theaccent	word	selected	tap	Edit	>	Fill	menu	and	changeit	to	No	Fill,	tap	the	color	box	to	change	the	accentword	color	if	desired,	and	tap	Make	It!	Practice	this	at	|Page	92
Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	the	CHANGE	FONTfont	for	existing	textStep	1:	Open	Step	2:	Tap	theyour	project	and	font	menu	in	thedouble-tap	the	lower	left	cornertext	you	want	to	to	view	the	fontchange	the	font	list.for.Step	3:	Scroll	Your	font	changes!through	the	listand	tap	the	newfont	you	want	touse.	•	If	text
is	multi-layered	and	one	layer	is	hidden,	you	can	use	the	Slice	tool.	When	done	editing,	tap	Save.Step	6:	Step	7:	Step	8:	AsType	in	Go	to	soon	asa	note	Facebook,	the	linkand	click	find	the	opens,	tapPost.	shapes,	text,So	either	tap	and	projects!Keep	Previous(if	you	want	to	OPEN	&	START	PROJECTsee	what	youleft	there)	ortap	Replace	fora	new,
blankcanvas.	Tip:	Type	a	word	or	two	UPLOAD	IMAGES	(IOS)	as	a	tag	to	help	you	find	this	image	later	in	a	search.	Add	at	least	one	landscape	photo	by	tapping	the	+	button.Note:	If	your	design	has	any	purchased	elements	from	Cricut	Access	or	cartridges,anyone	attempting	to	use	your	design	either	must	also	have	them,	and	if	they	donot,	they	will
be	prompted	to	pay	for	them	before	cutting.Step	3:	Step	4:	Edit	Step	5:	Tap	SHARE	PROJECT	LINKSToggle	your	title	Facebook	toVisible	to	as	needed	share	yourOthers	and	add	a	project.to	On	description.(green).	11Step	4:	Step	5:	Step	6:	Step	7:Tap	the	image	file	,	Clean	it	up	(if	Choose	an	image	Tap	the	uploadedsuch	as	PNG,	JPG,	GIF,	you	want)
and	type,	name	it,	and	image	and	thenor	JPG.	your	photos.	The	Cricut	Makers	add	Engrave,	Deboss,	Wave,	and	Perf.	A	box	will	appear	that	shows	you	what	font	was	originally	used.	(optional),	and	click	Save.Step	3:	Wait	while	Cricut	saves	your	project—	SAVE	WORK/PROJECTSwhen	saved,	a	blue	confirmation	box	will	flashnear	the	top	of	your	screen
and	the	new	name	Collections	allow	you	to	organize	projects	youwill	appear	at	the	top	of	the	window.	Check	the	status	site	for	it	to	come	back.	For	best	results,	connect	yourwill	need	to	be	inserted	into	a	USB	port	on	your	Cricut	to	your	computer	via	the	USB	cable.computer	first.Step	3:	Once	the	cartridge	is	detected,	the	Link	Step	4:	Once	the	link	is
complete,	remove	theCartridge	button	will	become	available.	Holdnew	SnapMat	your	device	parallel	tophotos	for	the	surface.each	mat.)	Practice	this	at	|Page	66	Copyright	JenniferMaker®Cricut®	Coach	PlaybookHow	to	save	work	and	view	saved	projectsStep	1:	Create	Step	2:	Tap	Save	from	SAVE	WORK/PROJECTSsomething	and	the	drop-down
menutap	the	Save	that	appears.	Sometimes	projects	and	uploaded	imageswill	be	grouped	when	you	open/insert	them,	and	you’ll	need	to	ungroup	them	so	you	can	make	changes.How	to	Group:	Step	2:	With	all	objects	you	want	Step	1:	Tap	Layers	to	be	in	a	group	and	select	each	selected	(the	left	side	layer	you	want	to	of	the	layers	turn	group	together.
Practice	this	at	|Page	59	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	to	change	colorsStep	1:	Select	(tap)	Step	2:	Tap	Editthe	layer	you	want	then	tap	the	circleto	change,	like	above	the	Linetypethe	center	of	this	option.flower.Step	3:	Select	(tap)	Your	object	changes	CHANGE	COLORSthe	color	you	want.	to	get	choose	a	the	right	custom
settings.	If	you	need	to	make	more	changes,way	you	want	it	to,	click	the	X	in	the	upper	just	click	the	Contour	tool	again.right	hand	corner	to	return	to	your	canvas.Tip:	Contour	isn’t	permanent	so	long	as	you	don’t	Weld	your	images!	If	you	decide	later	you	want	aContoured	image	to	go	back	the	way	it	was,	or	simply	edit	it	further,	all	the	hidden	parts
are	retained!	Practice	this	at	|Page	13	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	tocurve	textStep	1:	Click	the	Text	tool	and	Step	2:	Select	the	text	and	clickadd	some	text.	Yes	NoStill	having	problems?	Is	it	installed	and	up-to-date?Yes	Restart	your	device.	CHANGE	FONT	While	you	can’t	change	a	font	you’ve	welded	(unless	you’re	able
to	Undo	and	unweld	it	because	you	haven’t	saved	and	reopened	your	project),	there	is	a	way	to	tell	WHICH	font	you	used	so	you	canCoach	re-create	it.	key	as	you	click	each	layer),	then	click	Slice.After	you	click	Slice,	three	or	more	new	layers	Step	3:	Move,	hide,	or	delete	the	layers	youcalled	“Slice	Result”	will	appear.	If	you	need	to	setpattern	fills,
use	a	desktop	or	laptop	to	access	Cricut	Design	Space	and	see	directions	on	page	21.	click	the	Ungroup	icon.Step	3:	Select	any	layers	(two	or	more)	you	want	Tip:	If	you	are	having	a	problem	attachingto	attach	together	(hold	down	the	Shift	key	layers,	try	ungrouping	layers	first.while	you	click	to	select	multiple	layers),	then	Score	lines	must	be
attached	with	theclick	Attach	in	the	lower	right	corner.	Printers	window	of	the	Control	Panel.Once	connected,	you	can	select	your	machinefrom	the	drop-down	menu	in	Cricut	Design	Space.	your	iPhone	or	iPad.Step	3:	Step	4:	Step	5:Tap	Locate	TapiPhone	the	DeleteStorage	Cricut	App.or	iPad	Design	Step	8:Storage,	app	and	Tap	openbased	on	tap	it.
orPC	MAC	OPEN	&	START	PROJECTStep	2:	If	prompted,	sign	in	with	your	email	andStep	3:	Click	the	New	Project	icon	on	the	leftpassword.	Engraving	Tool	(Makers	only).	Tap	the	uploaded	image	appears	on	yourNOT	tap	the	ZIP	file—it	SVG	and	then	tap	canvas,	ready	to	bewill	give	you	an	error).	Cricut®	and	Cricut	Design	Space®are	registered
trademarks	of	Provo	Craft.	Step	6:	Some	may	Adjust	the	have	a	Font	Size	fee,	like	and	Letter	this:	Space	as	Step	5:	necessary	Select	so	it	looks	Draw	and	the	way	tap	a	pen	you	want	type	and	it	to	look,	color.	You	must	click	each	one	and	select	“Save	for	Offline”	individually.•	If	you	go	offline,	you’ll	only	be	able	to	view	and	access	projects	saved	on
your	iPhone	or	iPad.•	Any	images	you	have	in	a	project	from	Cricut	Access	will	expire	after	30	days	if	you	do	not	go	online	at	all	during	those	30	days	(even	if	you	have	monthly	access).	Practice	this	at	|Page	68	Copyright	JenniferMaker®Cricut®	Coach	Playbook	How	toshare	links	to	projectsDid	you	make	an	awesome	design	and	now	want	to	share	it?
it.	remove	with	theAllow	it	the	back-	otherto	replace	ground.	Does	something	just	not	seem	right?	Once	Cricut	Design	INSTALL	DESIGN	SPACE	(PC)	Space	is	installed	on	your	PC,	an	icon	will	appear	on	your	desktop	as	well	as	in	your	taskbar.	of	the	images	you	want	to	weld	together,	tap	on	Actions	at	the	bottom	of	the	screen,	then	tap	Weld.
Save.Step	7:	Tap	Step	8:	Step	9:the	first	Select	each	Recolorproject’s	duplicate	eachimage,	tap	copy	and	elementActions,	tap	Actions	(see	pagetap	>	Hide	21)	asDuplicate,	Contour	neededand	make	(see	page	and	moveas	many	53)	to	back	intoduplicates	separate	position.as	there	out	each	Noware	element	your	twoelements	into	its	own	projectsin	the
layer.	You	can	on	this	virtualalso	rotate.	Yes	No	TROUBLESHOOTINGKeep	the	Design	Space	Yes	No	Connect	to	Internet	&	Having	different	problems?app	active	and	don’t	move	your	Cricut	and	Here	are	more	solutions:move	away	while	cutting.	Here’s	how	to	set	your	machine	and	change	the	operation.Step	1:	Click	the	menu	to	the	Step	2:	Select
(click)	a	layer	and	Use	Basic	Cut	for	fine	point,	deepleft	of	the	Make	It	button	and	click	on	the	Operation	menu	at	cut,	fabric,	knife	(Makers	only),choose	your	machine.	When	your	image	looks	the	you	want	it.
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